QGC Guide (master)

Menu Return to top

QGroundControl User Guide
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QGroundControl provides full flight control and vehicle setup for PX4 or ArduPilot powered

vehicles. It provides easy and straightforward usage for beginners, while still delivering

high end feature support for experienced users.
Key Features:

o Full setup/configuration of ArduPilot and PX4 Pro powered vehicles.

e Flight support for vehicles running PX4 and ArduPilot (or any other autopilot that
communicates using the MAVLink protocol).

e Mission planning for autonomous flight.

e Flight map display showing vehicle position, flight track, waypoints and vehicle
instruments.

o 3D viewer visualizing the 3D map of the environment (.osm file), the 3D model of the
vehicle (only multi-rotors for the moment), and the mission 3D trajectory (including the
waypoints).

» Video streaming with instrument display overlays.
e Support for managing multiple vehicles.

e QGC runs on Windows, OS X, Linux platforms, iOS and Android devices.
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INFO

This guide is an active work in progress. The information provided should be correct, but you may
find missing information or incomplete pages.

TIP

Information about QGroundControl development, architecture, contributing, and translating can be
found in the Developer Guide section.

Edit on GitHub

Next page
Quick Start
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QGroundControl Quick Start

Getting QGroundControl up and running is quick and easy:

1. Download and install the application.

2. Start QGroundControl.

3. Attach your vehicle to the ground station device via USB, through a telemetry radio, or
over WiFi. QGroundControl should detect your vehicle and connect to it automatically.

That's it! If the vehicle is ready to fly, QRGroundControl should display Fly View as shown
below (otherwise it will open Setup View).
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A good way to become familiar with QGroundControl is to start experimenting:

e Use the toolbar to switch between the main views:
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Settings: Configure the QGroundControl application.

Setup: Configure and tune your vehicle.

Plan: Create autonomous missions.

Fly: Monitor your vehicle(s) while flying, including streaming video.

3D View: A 3D visualization and monitoring of the vehicle, the 3D map of the
environment, and the mission while flying.

[Analyze] ** Description of Analyze view is missing **

¢ Click the Status icons on the toolbar to find out the status of the connected vehicle.

While the Ul is fairly intuitive, this documentation can also be referenced to find out more.

INFO

Make sure QGC has an internet connection when you connect a new vehicle. This will allow it to

get the latest parameter and other metadata for the vehicle, along with translations.

Edit on GitHub

Previous page Next page
Overview Download and Install
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Download and Install

The sections below can be used to download the current stable release of

QGroundControl for each platform.

TIP

See Troubleshooting QGC Setup if QGroundControl doesn't start and run properly after

installation!

System Requirements

QGC should run well on any modern computer or mobile device. Performance will depend
on the system environment, 3rd party applications, and available system resources. More
capable hardware will provide a better experience. A computer with at least 8Gb RAM, an

SSD, Nvidia or AMD graphics and an i5 or better CPU will be suitable for most applications.

For the best experience and compatibility, we recommend you the newest version of your

operating system.

Windows

QGroundControl can be installed on 64 bit versions of Windows:

1. Download QGroundControl-installer.exe.

2. Double click the executable to launch the installer.

INFO [m



The Windows installer creates 3 shortcuts: QGroundControl, GPU Compatibility Mode, GPU Safe
Mode. Use the first shortcut unless you experience startup or video rendering issues. For more
information see Troubleshooting QGC Setup > Windows: Ul Rendering/Video Driver Issues.

INFO

Prebuilt QGroundControl versions from 4.0 onwards are 64-bit only. It is possible to manually build

32 bit versions (this is not supported by the dev team).

Mac OS X

QGroundControl can be installed on macOS 10.11 or later:

1. Download QGroundControl.dmg.

2. Double-click the .dmg file to mount it, then drag the QGroundControl application to your
Application folder.

INFO

QGroundControl continues to not be sighed which causes problem on Catalina. To open QGC app

for the first time:

¢ Right-click the QGC app icon, select Open from the menu. You will only be presented with an

option to Cancel. Select Cancel.

e Right-click the QGC app icon again, Open from the menu. This time you will be presented with

the option to Open.

Ubuntu Linux
QGroundControl can be installed/run on Ubuntu LTS 20.04 (and later).

Ubuntu comes with a serial modem manager that interferes with any robotics related use

of a serial port (or USB serial). Before installing QGroundControl you should remove the
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modem manager and grant yourself permissions to access the serial port. You also need to

install GStreamer in order to support video streaming.

Before installing QGroundControl for the first time:

1. On the command prompt enter:

sudo
sudo
sudo
sudo

sudo

sh
usermod -a -G dialout $USER

apt-get remove modemmanager -y
apt install gstreamerl.@-plugins-bad gstreamerl.@-libav gstreamerl.0-gl -y
apt install libfuse2 -y

apt install libxcb-xinerama® libxkbcommon-x11-© libxcb-cursor@ -y

2. Logout and login again to enable the change to user permissions.

To install QGroundControl:

1. Download QGroundControl.Appimage.

2. Install (and run) using the terminal commands:

sh

chmod +x ./QGroundControl.AppImage

./QGroundControl.AppImage (or double click)

INFO

There are known video steaming issues on Ubuntu 18.04 systems with dual adaptors.

INFO

Prebuilt QGroundControl versions from 4.0 cannot run on Ubuntu 16.04. To run these versions on

Ubuntu 16.04 you can build QGroundControl from source without video libraries.

Android



QGroundControl is temporily unavailable from the Google Play Store. You can install

manually from here:

e Android 32 bit APK

e Android 64 bit APK

Old Stable Releases

Old stable releases can be found on GitHub.

Daily Builds

Daily builds can be downloaded from here.

Edit on GitHub

Previous page
Quick Start

Next page
Toolbar/Menu
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Main Toolbar

The main toolbar provides access to select the different application views, and high level
status information for connected vehicles. The toolbar is the same in all views except for

"PlanView" (which has a single icon to take you back to "Fly" view).

View-select icons

The following icons are used to switch between the main Views. These are displayed even
if no vehicle is connected.

Settings
Configure the QGroundControl application.

Setup

Configure and tune your vehicle.

Plan

Create autonomous missions.

Fly
Monitor your vehicle(s) while flying, including streaming video.



3D View

3D Visualization and monitoring of the vehicle and the environment while flying.

Analyze

Download logs, geotag images from a survey mission, access the MAVLink console.

Status icons

Status icons are displayed when QGroundControl is connected to a vehicle. These show

the high level status of the vehicle, and can be clicked to see more detailed information.

Vehicle Messages
Click to show a list of messages from the vehicle. Note that version on the right is

displayed when there are critical messages.

GPS Status

Shows you satellite count and curent HDOP.

RC RSSI

RC signal strength information.

——y

Telemetry RSSI

Telemetry signals strength information.



Battery

Remaining battery percent.

Flight Mode
Current flight mode. Click to change flight mode.

RTK GPS Survey-In Status

Shows you progress of RTK GPS Survey-In process.

Edit on GitHub

Previous page
Download and Install
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Support
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Support

This user guide is meant to be the main provider of support for QGroundControl. If you find

incorrect or missing information please report an Issue.

Questions about how to use QGroundControl should be raised in the discussion forum for

the associated flight stack:

e PX4 Pro Flight Stack (discuss.px4.io).

e ArduPilot Flight Stack (discuss.ardupilot.org).

These forums are also the best place to start discussions on bugs/problems you are
having with QGroundControl and or feature requests you would like to make. From there

you may be directed to entering information in a GitHub Issue for further resolution.

Developer Chat

QGroundControl developers (and many regular/deeply-involved users) can be found on the

#QGroundControl channel on the Dronecode Discord.

GitHub Issues

Issues are used to track bugs against QGroundControl as well as feature requests for later

versions. The current list of issues can be found on GitHub here.

INFO

Please contact our developers using the support forums before creating GitHub issues for either

bugs or feature requests.
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Reporting Bugs

If you are directed to create an issue, please use the "Bug report" template and provide all

information specified in the template.
Reporting Crashes from Windows Builds

When QGC crashes a crash dump file will be place in the Users LocalAppData directory. To
navigate to that directory use the Start/Run command. You can bring this up window
WinKey+R. Type into that %localappdata% for Open and click Ok. Crash dumps will be in a
QGccrashbumps folder in that directory. You should find a new .dmp file there. Add a link to

that file in a GitHub Issue when reporting you problem.
Reporting Hangs from Windows Builds

If Windows is telling you the QGroundControl program is unresponsive use the following

steps to report the hang:

1. Open Task Manager (right-click TaskBar, select Task Manager)
2. Switch to the Processes tab and local qgroundcontrol.exe

3. Right-click on groundcontrol.exe and select Create Dump File
4. Place the dump file in a public location

5. Add a link to the .dmp file and above details in the GitHub issue.

Feature Requests

If you are directed to create a feature request after discussion on support forums please

use the "Feature request" template which has some helpful information on required details.

Troubleshooting

Troubleshooting information is linked from here.

Console Logging



Console Logs can be helpful when diagnosing QGroundControl problems. For more

information see: Console Logging.

Help Improve these Docs!

Just like QGroundControl itself, the user guide is an open source, user created and

supported GitBook. We welcome Pull Requests against the guide for fixes and/or updates.

Edit on GitHub

Previous page Next page
Toolbar/Menu Fly
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Fly View
The Fly View is used to command and monitor the vehicle when flying.

You can use it to:

e Run an automated pre-flight checklist.

e Arm the vehicle (or check why it won't arm).

» Control missions: start, continue, pause, and resume.

e Guide the vehicle to arm/disarm/emergency stop, takeoff/land, change altitude, go to
or orbit a particular location, and return/RTL.

e Switch between a map view and a video view (if available)

» Display video, mission, telemetry, and other information for the current vehicle, and also
switch between connected vehicles.
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Ul Overview
The screenshot above shows the main elements of the fly view:

e Map: Displays the positions of all connected vehicles and the mission for the current
vehicle.

e You can drag the map to move it around (the map automatically re-centres after a
certain amount of time).

e Once flying, you can click on the map to set a Go to or Orbit at location.

« Fly Toolbar: Key status information for sensors (GPS, battery, RC control), and vehicle
state (Flight mode, Armed/Disarmed status).

e Select the sensor indicators to view more detail.

e Press the Flight mode text (e.g. "Hold") to select a new mode. Not every mode may
be available.

e The text next to the Q icon indicates the flight readiness using text: "Not Ready",
"Ready to Fly", "Flying", and status using colour: "green" (all good!), amber (am

v



warning), red (serious problem). Select the text when the background is amber or red
to find out the cause of any preflight issues (QGC 4.2.0 and later). You can also select
the text to reach a button to arm/disarm/emergency-stop the vehicle.

¢ Fly tools: You can use these to:
e Toggle between takeoff/land.
o Pause/restart the current operation (e.g. landing, or the mission).
o Safety return (also known as RTL or Return).

e The Action button offers other appropriate options for the current state (these
overlay the Confirmation Slider). Actions include changing the altitude or continuing a
mission.

o Enable the preflight checklist (tool option disabled by default).

o Instrument Panel: A widget that displays vehicle telemetry.

o Attitude/Compass: A widget that provides virtual horizon and heading information.

o Camera Tools: A widget for switching between still and video modes, starting/stopping
capture, and controlling camera settings.

e Video/Switcher: Toggle between video or map in a window.

e Press the element to switch Video and Map to foreground.

e QGroundControl supports RTP and RTSP video streaming over your vehicles UDP
connection. It also supports directly connected UVC devices. QGC video support is
further discussed in the Video README.

o A Telemetry Overlay is automatically generated as a subtitle file

o Confirmation Slider: Context sensitive slider to confirm requested actions. Slide to start
operation. Press X to cancel.

There are a number of other elements that are not displayed by default/are only displayed
in certain conditions. For example, the multi-vehicle selector is only displayed if you have
multiple vehicles, and the preflight checklist tool button is only displayed if the appropriate

setting is enabled.

Instrument Panel (Telemetry)

The instrument panel displays telemetry information about the current vehicle.

]
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The default values include altitude (relative to the home location), horizontal and vertical

speed, total flight time, and distance between vehicle and ground station.

You can configure where the information is displayed by hovering over the panel and
selecting the left-side square tool. This toggles the position of the panel between bottom

centre and right-centre.
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You configure what information is display by selecting the edit/pencil icon. The grid will

then display "+" and "-" icons that you can use to add or remove rows and columns (and

the pencil icon is replaced by a "lock" icon that you can use to save the settings).
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Select a value to launch its "Value Display" editor. This allows you to change the icon, text,

size, units and so on of the current telemetry value.

-
Value Display

AltitudeRelative =

Show Linits

8 dr”‘;l‘E

9

The selection list on the top left is used to change the source of the telemetry. By default
this is the venhicle, but you can use the selector to choose a particular sensor type| DiSA_ v



Vehicle
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The selection list on the top right is used to select a particular telemetry value for the

vehicle or sensor.
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Camera

The camera panel is used to capture still images and video, and to configure the camera.

. widoo Grab O Camaa Trigoar

O
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The camera capture and configuration options depend on the connected camera. The
configuration options are selected using the panel gear icon. The configuration for a simple

autopilot-connected camera are shown below. DISA v
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When connected to camera that supports the MAVLink Camera Protocol you can

additionally configure and use other camera services that it makes available. For example,
if your camera supports video mode you will be able to switch between still image capture

and video mode, and start/stop recording.

Video Settings

Camera Selector:

Brightness
Contrast
Saturation
Gain
Sharpness

Backlight Compensation

Power Line Frequency

White Balance Mode Auto

Exposure Mode Aperture Priority Mode

Exposure Auto Priority

Reset Camera Defaults Reset

Storage Format

INFO

Most of the settings that are displayed depend on the camera (they are defined in its MAVLink

]

Camera Definition File).




A few common settings at the end are hard-coded: Photo Mode (Single/Time Lapse), Photo
Interval (if Time Lapse), Reset Camera Defaults (sends a reset command to the camera), Format
(storage) :::

Video Stream

The video page is used to enable/disable video streaming. When enabled, you can start/stop the
video stream, enable a grid overlay, change how the image fits the screen, and record the video
locally with QGC.

Video Stream -

Enable Stream

Grid Lines

Record Stream

Video Scresn Fit
ik

Actions/Tasks

The following sections describe how to perform common operations/tasks in the Fly View.

INFO

Many of the available options depend on both the vehicle type and its current state.

Pre Flight Checklist

An automated preflight checklist can be used to run through standard checks that the

vehicle is configured correctly and it is safe to fly.
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To view the checklist, first enable the tool by navigating to Application Settings > General

> Fly View and selecting the Use preflight checklist checkbox. The tool will then be added
to the Flight Tools. Press it to open the checklist:

F‘|-.l
Pre-Flight Checklist

Ir: Initial checks
4) |

Hardware: Frops mounted? Wings secured?
Takeat Tail securad?

Battery; Battery connector firmly plugged?

Sensors: Passed
GPS: Passed

Radio Control: Receiving signal. Perform
range test & canfirm,

Once you have performed each test, select it on the Ul to mark it as complete.

Arming and Preflight Checks

Arming a vehicle starts the motors in preparation for takeoff. You will only be able to arm

the vehicle if it is safe and ready to fly.

TIP

Generally, if the vehicle is ready to arm, QGroundControl will arm the vehicle for you if you start a
mission or takeoff.

The vehicle is ready to fly in all modes if the status text says "Ready to Fly" and the

background is green.
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If the background is amber then it is ready to take off in the current mode, but may not be

able to switch to other modes. If the background is red and the text is "Not Ready" then

you will not be able to arm in the current mode.

@ Not Ready

From QGC 4.2.0 (at time of writing, a daily build) you can find out the exact cause of the

warning or error, and possible solutions, by pushing the status text.

This launches the preflight arming checks popup with a list of all preflight warnings. The

toggle on the right expands each error with additional information and possible solutions.

Once each issue is resolved it will disappear from the Ul. When all issues blocking arming
have been removed you can use the arm button to display the arming confirmation slider,
and arm the vehicle (or you can just take off - note that the vehicles will (by default)

disarm automatically if you do not take off after a few seconds.

Arm the vehicle.

L
’ Slide or hold spacebar .

INFO

The status text also displays when flying.

| Q]| Armed

>



The arming checks Ul will open even when flying, allowing you to emergency disarm. ::

Disarm
Disarming the vehicle when landed stops the motors (making the vehicle safe).

Generally you do not need to explicitly disarm as vehicles will disarm automatically after landing, or

shortly after arming if you do not take off.

If needed, you can do so from the Arming Preflight Checks Ul.

You will then need to use the disarming slider.

Disarm the vehicls

Slide or hold spacebar .

INFO

Disarming the vehicle while it is flying is called an Emergency Stop

Emergency Stop

Emergency stop is effectively the same as disarming the vehicle while it is flying. Your

vehicle will crash!

If needed, you can do so from the Arming Preflight Checks Ul.



You will then need to use the emergency disarming slider.

WARNING: THISWILL STOP ALL MOTORS. IF
VEHICLE IS CURRENTLY IN THE AIR IT WILL
CRASH.

. Slide or hold spacebar .

Takeoff

TIP

If you are starting a mission for a multicopter, QGroundControl will automatically perform the
takeoff step.

To takeoff (when landed):

1. Press the Takeoff button in the Fly Tools (this will toggle to a Land button after taking
off).
2. Optionally set the takeoff altitude in the right-side vertical slider.

3. Confirm takeoff using the slider.
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Takeoff from ground and hold position.

. Slide to confirm

Land

You can land at the current position at any time while flying:

1. Press the Land button in the Fly Tools (this will toggle to a Takeoff button when landed).

2. Confirm landing using the slider.
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RTL/Return

Return to a "safe point" at any time while flying:

1. Press the RTL button in the Fly Tools.
2. Confirm RTL using the slider.

! ’

X

S RTL

Return to the home position of the
venicie.

. Slide to confirm

INFO

Vehicles commonly return to the "home" (takeoff) location and land. This behaviour depends on
the vehicle type and configuration. For example, rally points or mission landings may be used as

alternative return targets.

Change Altitude
You can change altitude while flying, except when in a mission:
1. Press the Action button on the Fly Tools

2. Select the Change Altitude action from the dialog.
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3. Move the vertical slider to the desired altitude, then drag the confirmation slider to start

the action.
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Change the altitude of the vehide up or
down,

. Slide to confirm

Goto Location
After taking off you can specify that you want to fly to a particular location.

1. Left click/Press on the map where you want the vehicle to move and select Go to
location on the popup.

Go to location
Orbit at location

1. The location will be displayed on the map, along with a confirmation slider.
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Goto Location

Move the vehicle to the specified location.

. Slide to confirm

2. When you're ready, drag the slider to start the operation (or press the X icon to cancel

it).

INFO

Goto points must be set within 1 km of the vehicle (hard-coded in QGC).

Orbit Location
After taking off you can specify that you want to orbit a particular location.

1. Left click/Press on the map (near the centre of your desired orbit) and select Orbit at
location on the popup.

Go to location
Orbit at location

1. The proposed orbit will be displayed on the map, along with a confirmation sider.




location.

Slide to confirm

o Select and drag the central marker to move the orbit location.

o Select and drag the dot on the outer circle to change the orbit radius

2. When you're ready, drag the slider to start the operation (or press the X icon to cancel

it).

Pause

You can pause most operations, including taking off, landing, RTL, mission execution, orbit
at location. The vehicle behaviour when paused depends on the vehicle type; typically a

multicopter will hover, and a fixed wing vehicle will circle.

INFO

You cannot pause a Goto location operation.

To pause:

1. Press the Pause button in the Fly Tools.
2. Optionally set a new altitude using the right-side vertical slider.

3. Confirm the pause using the slider.
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Missions
Start Mission

N New Alt(rel)

You can start a mission when the vehicle is landed (the start mission confirmation slider is

often displayed by default).
To start a mission from landed:
1. Press the Action button on the Fly Tools

2. Select the Start Mission action from the dialog.
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(to display the confirmation slider)

3. When the confirmation slider appears, drag it to start the mission.

Start Mission

Takeoff from ground and start the current

mission.

. Slide to confirm

Continue Mission

You can continue mission from the next waypoint when you're flying (the Continue Mission
confirmation slider is often displayed by default after you takeoff).

INFO

Continue and Resume mission are different! Continue is used to restart a mission that has been

paused, or where you have taken off, so you've already missed a takeoff mission command.
Resume mission is used when you've used a RTL or landed midway through a mission (e.g. for a
battery change) and then wish to continue the next mission item (i.e. it takes you to where you

were up to in the mission, rather than continuing from your place in the mission).

You can continue the current mission while (unless already in a mission!): DISA



1. Press the Action button on the Fly Tools

2. Select the Continue Mission action from the dialog.
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3. Drag the confirmation slider to continue the mission.

Continue Mission

Continue the mission from the current

Wwaypoint.

. Slide to confirm

Resume Mission

Resume Mission is used to resume a mission after performing an RTL/Return or Land from

within a mission (in order, for example, to perform a battery change).

INFO



If you are performing a battery change, do not disconnect QGC from the vehicle after
disconnecting the battery. After you insert the new battery QGroundControl will detect the vehicle
again and automatically restore the connection.

After landing you will be prompted with a Flight Plan complete dialog, which gives you the
option to remove the plan from the vehicle, leave it on the vehicle, or to resume the

mission from the last waypoint that was traveled through.

File Widgets

é 100% Return Disarmed

Flight Plan complete

Remove plan from vehicle

Leave plan on vehicle

Resume Missicn From Waypeint 6

Resume Mission will rebuild the current mission
from the last flown waypoint and upload it to the
vehicle for the next flight.

If you select to resume the mission, then QGroundControl will rebuild the mission and

upload it to the vehicle. Then use the Start Mission slider to continue the mission.

The image below shows the mission that was rebuilt after the Return shown above.
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INFO

A mission cannot simply resume from the last mission item that the vehicle executed, because
there may be multiple items at the last waypoint that affect the next stage of the mission (e.g.
speed commands or camera control commands). Instead QGroundControl rebuilds the mission,
starting from the last mission item flown, and automatically prepending any relevant commands to

the front of the mission.

Remove Mission Prompt After Landing

You will be prompted to remove the mission from the vehicle after the mission completes
and the vehicle lands and disarms. This is meant to prevent issues where stale missions

are unknowingly left on a vehicle, potentially resulting in unexpected behavior.

Display Video

When video streaming is enabled, QGroundControl will display the video stream for the
currently selected vehicle in the "video switcher window" at the bottom left of the map.
You can press the switcher anywhere to toggle Video and Map to foreground (in the image

below, the video is shown in the foreground).

]



File Widgets

INFO

Video streaming is configured/enabled in Application Settings > General tab > Video.

You can further configure video display using controls on the switcher:

e Resize the switcher by dragging the icon in the top right corner.

» Hide the switcher by pressing the toggle icon in the lower left.

|
|



e Detach the video switcher window by pressing on the icon in its top left corner (once
detached, you can move and resize the window just like any other in your OS). If you
close the detached window the switcher will re-lock to the QGC Fly view.

Record Video

If supported by the camera and vehicle, QGroundControl can start and stop video
recording on the camera itself. QGroundControl can also record the video stream and save

it locally.
TIP
Video stored on the camera may be of much higher quality, but it is likely that your ground station

will have a much larger recording capacity.

Record Video Stream (on GCS)

Video stream recording is controlled on the video stream instrument page. Press the red
circle to start recording a new video (a new video file is created each time the circle is

pressed); the circle will change into a red square while recording is in progress.



File Widgets

|
|

Video stream recording is configured in the Application Settings > General tab:

» Video Recording - specifies the recording file format and storage limits.

INFO

Videos are saved in Matroska format (.mkv) by default. This format is relatively robust against

corruption in case of errors.

e Miscellaneous - Streamed video is saved under the Application Load/Save Path.

TIP

The stored video includes just the video stream itself. To record video with QGroundControl
application elements displayed, you should use separate screen recording software.

Record Video on Camera DISA v



Start/stop video recording on the camera itself using the camera instrument page. First

toggle to video mode, then select the red button to start recording.

a Camera -

PiCam

Free Space: 50.0MB

Edit on GitHub

Previous page Next page
Support Replay Flight Data
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Replay Flight Data

WARNING

This feature is intended primarily for autopilot developers/vehicle creators. It is only supported on
desktop builds (Windows, Linux, Mac OS).

The Replay Flight Data feature allows users to replay a telemetry log, enabling review of

past or problematic flights. The flight can be started, paused, stopped, restarted etc.

INFO

QGroundControl treats flight replay like an active connection. When you pause/stop playing, the
ground station will report "Communication Lost" and wait for disconnection or for more messages.

To replay a flight:
1. Disconnect any active connections.
2. Select Application Settings > General > Fly View

3. Check Show Telemetry Log Replay Status Bar to toggle the flight replay bar at the
bottom of the screen.



@) % o 4 B

Application Settings

Fly View
General

Comm Links

it
Talsync Virtual Joystick

. Use Vertical Instrument Panel

.ShD'H additional heading indicators on Compass

[l Use Preflight Checklist

Microhard

MAVLnk Il Lock Compass Nose-Up

Guided Minimum Altitide

Guided Maximum Altitude 122 m

Console

Fiep Go To Location Max Distance U] m

Plan View
Default Mission Altitude m

AutoConnect to the following devices

pixnawk [¥4 SiK Radio [®@Px4 Flow [P Librerilot [ uop PRTK GPs

NMEA GPS Device : Disabled - |

4. Select the Load Telemetry Log button in the bar to display a file selection dialog.

e Choose alog file to replay from the available telemetry logs.

e QGroundControl will immediately start playing the log.
5. When a log is loaded you can use the:

e Pause/Play button to pause and restart playing.
o Slider to drag to a new position in the log.

o Rate selector to choose the playback speed.

6. To stop replay (i.e. to load a new file to replay), first pause the flight, and then select
Disconnect (when it appears). After disconnecting, the Load Telemetry Log button will

be displayed.

TIP

You can inspect the running replay in more detail using the MAVLink Inspector.
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Video Overlay

When QGroundControl is recording a video stream to a file, it will also export a subtitle file
with telemetry data that can be used to overlay the telemetry on the video during
playback. Whichever telemetry values are selected for display in the telemetry values

widget will also be exported to the overlay. The overlay values are updated at 1Hz.

ﬂ Values -

Raoll Pitch
-0.7 0.0

deg deg

Heading Latitude

151 0.0000000

deg

Longitude Sat Count

0.0000000 0

il B s
voilage

0.00

The selected values are laid out in three columns to optimize the screen utilization.



5 Jun 2019 17:12:17

Latitude: 0.0000000
l'ongitude: 0.0000000 - Volitage: 000wy,
BeSat GCount: O o310} Current: -1.005A

Playing

The overlay can be used with any player that supports the SubStation Alpha subtitle

format. Most players will open both files together when you try to play the video. They
need to be in the same folder and with the same name, which is how they are created by
QGC.

Permanent Video Subtitles using Handbrake

Subtitles can be permanently added to a video file using HandBrake. This will make the
subtitles permanently visible on any video player.

Open HandBrake, you should see its main interface. Click Open and select the video file.

e



HandBrake

File Queue View Presets Help

Open Source Add T | 5t Palse Presets Preview Gueue Activity
Source: No Title Found
Title: Mo Title Found Chapters: »

Preset: Official > General > Fast1080p30
Summary Dimensions Subtitles Chapters

Format: MPEG-4 [avformat) ¥
Web Optimized
¥ Align AfV Start
iPod 5G Support

Duration: 00:00:00

Tracks:

Filters:

Size:

Save As: NewVideo.m4y To: [ Videos

With the video file loaded, switch to the subtitles tab. Click Add to load the subtitle file.

HandBrake

File Queue View Presets Help

o

Open Source Add To Queue Start ¢ Presets Preview Gueue Activity

Source: 2019-04-19_17.16.54, 1920x1080 (1920x1080}, 16:9, 16,6667 FP5, 0 Audio Tracks, O Subtitle Tracks
Title: 1-00h00m23s - 2019-04-19_17.16.54 w* Range: Chapters ™ 1

Preset: Official > General > Fast 1080p30 b
Summary Dimensions Filters Video Audio Subtitles Chapters

Track List 4= Add 4 AddAl 4 ForeignAudioScan (@ Reload

Track Selection

Save As:  2019-04-19_17.16.54 (1).m4v To: [ Videos




Choose import SSA (ASS is an extension of SSA).
Cancel
® ImportSRT  Import SSA

Track Name:

Language Character Code Offset (ms)

Unknown UTF-8

File: (MNone)

Burn intovideo
Set Default Track

Load the .ass file corresponding to your video and tick the Burn into video checkbox.

Import SRT ® Import SSA

Track Name:

Language Offset (ms)

Unknown

File (Mone)

Burn into video

set Default Itack

Choose where you want to save the new file and click Start.



HandBrake
File Queue View Presets Hel
p

o

Open Source Add To Queue Start

Presets Preview Queue Activity

Source: 2019-04-19_18.44.15, 1920 30), 16:9, 23,976 FP5, 0 Audio Tracks, 0 Subtitle Tracks

Title: ¥ Range! Chap

Preset:

Summary Dimensions Video Audio Chapters

Track List 4 Add

4 AddAll - ForeignAudioScan (@ Reload

Track Selection (SSA)2019-04-19 1B.4415.ass) —-> Burned Into Video

Save As: 2019-04-19_18.44.15 (1).m4y

This will start burning the subtitle and video to a new file.

Edit on GitHub
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Custom Mavlink Action

Both the Fly View and Joysticks support the ability execute arbitrary mavlink commands to
the active vehicle. In the Fly View these will show up in the Toolstrip Action list. With

Joysticks you can assign then to button presses.

Custom Actions File

The custom actions available are defined in a JSON file. The format of that file is as

follows:

{
"version": 1,
"fileType": "CustomActions”,
"actions":

[

{
"label": "First Command",
"description”: "This is the first command",
"mavCmd" : 10,
"compId": 100,
"paraml": 1,
"param2": 2,

¥

{
"label™": "Second Command",
"description”: "This is the second command",
"mavCmd" : 20,



Fields:

actions (required) - An array of json objects, one for each command

 label (required) - The user visible short description for the command. This is used as the
button text for the Fly View - Actions command list. For Joysticks, this is the command
you select from the dropdown. For Joysticks, make sure your name doesn't conflict with
the built in names.

o description (required) - This is a longer description of the command used in the Fly View
- Action list. This is not used by joysticks.

e mavCmd (required) - The command id of the mavlink command you want to send.

e compld (options) - The component id for where you want to send the command to. If
not specified MAv_COMP_ID AUTOPILOT1 is used.

e param1 thru param? (optional) - The parameters for the command. Parameters which

are not specified will default to 0.0

Custom action files should be located in the CustomActions directory of the QGC save

location. For example on Linux that would be ~/Documents/QGroundControl/CustomActions OF
~/Documents/QGroundControl Daily/CustomActions . The Fly View and Joysticks each have

there own custom actions files:

* Fly View - FlyViewCustomActions.json

o Joystick - JoystickCustomActions.json

When you start up QGC it will load these files if they exist and make the commands

available for use.

Edit on GitHub

Previous page Next page
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3D View

The 3D View is used to visualize and monitor the vehicle, the environment, and the

planned mission in 3D. Most of the capabilities available in the Fly View is also available in
the 3D View.

You can use it to:

e To import and display the 3D map for any region of interest downloaded from the
OpenStreetMap website (.osm file).

e Display the vehicle along with its mission in 3D.

e And most of the capabilities of the Fly View, including:

e Run an automated pre-flight checklist.

e Arm the vehicle (or check why it won't arm).

o Control missions: start, continue, pause, and resume.

o Guide the vehicle to arm/disarm/emergency stop, takeoff/land, change altitude, and
return/RTL.

e Switch between a map view and a video view (if available)

» Display video, mission, telemetry, and other information for the current vehicle, and
also switch between connected vehicles.



O

00:00:00

<o

Ul Overview

The screenshot above shows the main elements of the 3D View.

**Enabling the 3D View:** The 3D View is disabled by default. To enable it, go to
Application Settings > Fly View tab, and under the 3D View settings group, toggle the
Enabled switch as shown below:



Back < @] Application Settings

(@) General General

<ﬂ Fly View Use Preflig

ered On Vehicle

eturn to e pasit

Guided Commands

Minimum Altitude

Maximum Altitude

Virtual Joystick

Enabled

Instrument Panel
Show additional heading indicators on Compass

ock C Nose-Up

3D View

Enabled

ERANELRZIE brix/Qt_Projects/QGC/map_eurecom_small_2.0sm

Clear Select File
Average Building Level Height

es Altitude Bias

To open the 3D View, when you are in the Fly View, from the toolbar on the left, select the

3D View icon as illustrated below:

Once the 3D View is opened, you can navigate through the 3D environment by using either

a mouse or a touchscreen as follows:
e Mouse:

e To move horizontally and vertically: Press and hold the mouse left-click, then move

the cursor. DISA v



o Torotate: Press and hold the mouse right-click, then move the cursor.

e To zoom: Use the mouse wheel\middle button.
e Touchscreen:

o To move horizontally and vertically: Use a single finger, then tap and move your
finger.

o Torotate: Use two fingers, then tap and move your fingers while keeping them
together.

e To zoom: Use a pinch with two fingers and move them together or apart to zoom in
or out.

To visualize the 3D map of a particular area in the 3D viewer, you have to download the
.osm file of that area from the OpenStreetMap website and then import it through the 3D

View settings. More details on the 3D View settings can be found in the next section.

Settings

You can change the settings of the 3D View from Application Settings >Fly View tab
under the 3D View settings group. The following properties can be modified in the 3D

View settings group:

e Enabled: To enable or disable the 3D View.

o 3D Map File: The path to the .osm file of a region of interest to be visualized in the QGC.
The .osm file can be uploaded by clicking on the Select File button. To clear the 3D
View from the previously loaded .osm file, you can click on the Clear button.

» Average Building Level Height: This parameter determines the height of each storey of
the buildings, as in .osm file sometimes the height of the buildings is specified in terms
of the level/storey.

» Vehicle Altitude Bias: This refers to the bias in the altitude of vehicles and their
missions with respect to the ground level. It is helpful in cases where the estimated
altitude of the vehicle by its flight control is biased, as the relative altitude is currently
used in the 3D View.

Edit on GitHub



QGC Guide (master)

Menu On this page

Plan View

The Plan View is used to plan autonomous missions for your vehicle, and upload them to
the vehicle. Once the mission is planned and sent to the vehicle, you switch to the Fly

View to fly the mission.

It is also use to configure the GeoFence and Rally Points if these are supported by the

firmware.

O Mission @ Fence @ Rally

File

Add Waypoint

Pattern
Centre map

Zoomrin

' Zoom out
[ ] Flight Spaad

Camera

Terrain Altitude

Irchelpark

Ul Overview

The screenshot above shows a simple mission plan that starts with a takeoff at the
Planned Home position (H), flies through three waypoints, and then lands on the Ia‘ DISA v




waypoint (i.e. waypoint 3).

The main elements of the Ul are:

e Map: Displays the numbered indicators for the current mission, including the Planned
Home. Click on the indicators to select them (for editing) or drag them around to
reposition them.

e Plan Toolbar: Status information for the currently selected waypoint relative to the
previous waypoint, as well as statistics for the entire mission (e.g. horizontal distance
and time for mission).

e Max telem dist is the distance between the Planned Home and the furthest

waypoint.

 When connected to a vehicle it also shows an Upload button, can be used to upload
the plan to the vehicle.

e Plan Tools: Used to create and manage missions.

o Mission Command List/Overlay: Displays the current list of mission items (select items
to edit).

o Terrain Altitude Overlay: Shows the relative altitude of each mission command.

It shows you information related to the currently selected waypoint as well as statistics for

the entire mission.

Planning a Mission
At very high level, the steps to create a mission are:

1. Change to Plan View.
2. Add waypoints or commands to the mission and edit as needed.
3. Upload the mission to the vehicle.

4. Change to Fly View and fly the mission.

The following sections explain some of the details in the view.

Planned Home Position Disp_



The Planned Home shown in Plan View is used to set the approximate start point when
planning a mission (i.e. when a vehicle may not even be connected to QGC). It is used by

QGC to estimate mission times and to draw waypoint lines.

You should move/drag the planned home position to roughly the location where you plan

to takeoff. The altitude for the planned home position is set in the Mission Settings panel.

|I Planned Home Position

Actual position sat by vehicle at flight time

Set Home To Map Center

TIP

The Fly View displays the actual home position set by the vehicle firmware when it arms (this is
where the vehicle will return in Return/RTL mode).

Plan Tools

The plan tools are used for adding individual waypoints, easing mission creation for
complicated geometries, uploading/downloading/saving/restoring missions, and for

navigating the map. The main tools are described below.

INFO



Center map, Zoom In, Zoom Out tools help users better view and navigate the Plan view map
(they don't affect the mission commands sent to the vehicle).

Add Waypoints

Click on the Add Waypoint tool to activate it. While active, clicking on the map will add
new mission waypoint at the clicked location. The tool will stay active until you select it
again. Once you have added a waypoint, you can select it and drag it around to change its
position.

File (Sync)

The File tools are used to move missions between the ground station and vehicle, and to
save/restore them from files. The tool displays an ! to indicate that there are mission

changes that you have not sent to the vehicle.

INFO

Before you fly a mission you must upload it to the vehicle.

The File tools provide the following functionality:

e Upload (Send to vehicle)

« Download (Load from vehicle)

» Save/Save as to File, including as KML file.
e Load from File

« Remove All (removes all mission waypoints from Plan view and from vehicle)

Pattern

The Pattern tool simplifies the creation of missions for flying complex geometries,

including surveys and structure scans.

Mission Command List (osa_ ]



Mission commands for the current mission are listed on the right side of the view. At the
top are a set of options to switch between editing the mission, GeoFence and rally points.

Within the list you can select individual mission items to edit their values.

; Q Mission @ Fence @ Rally

et

P Mission Start

i: 1 Takeoff

Waypoint

i Travel to a pasition In 30 space,

Altitude =
100.00 m (Rel)

Altiude refative o home altiude

B Flight Speed

¢ Camera

Mission Command Editors

Click on a mission command in the list to display its editor (in which you can set/change

the command attributes).

You can change the type of the command by clicking on the command name (for example:
Waypoint). This will display the Select Mission Command dialog shown below. By default
this just displays the "Basic Commands", but you can use the Category drop down menu

to display more (e.g. choose All commands to see all the options).



Select Mission Command Cancel

Waypoint
Travel to a position in 3D space.

Retiirn Home
Send the vehicle back to the home
pasition.

Land
Land vehicle at the specified location.

Takeoff
Take off from the ground and travel
towards the specified position.

To the right of each command name is a menu that you can click to access to additional
options such as Insert and Delete.

INFO

The list of available commands will depend on firmware and vehicle type. Examples may include:
Waypoint, Start image capture, Jump to item (to repeat mission) and other commands.

Mission Settings

The Mission Start panel is the first item that appears in the mission command list. It may

be used to specify a number default settings that may affect the start or end of the
mission.

0O Mission @ Fence @ Ral-,-

P Mission Start

- 1 Takeoff




Waypoint alt

' Flight speed E

Camera

Mission End
B Return To Launch

Vehicle Info

Planned Home Position

Mission Defaults
Waypoint alt

Set the default altitude for the first mission item added to a plan (subsequent items take an
initial altitude from the previous item). This can also be used to change the altitude of all
items in a plan to the same value; you will be prompted if you change the value when there

are items in a plan.
Flight speed
Set a flight speed for the mission that is different than the default mission speed.

Mission End
Return to Launch after mission end

Check this if you want your vehicle to Return/RTL after the final mission item.
Planned Home Position

The Planned Home Position section allows you to simulate the vehicle's home position

while planning a mission. This allows you to view the waypoint trajectory for your vehicle

from takeoff to mission completion.

Planned Home Position

Actual pesition set by vehicle at fight dme.

Set Home To Map Center




INFO

This is only the planned home position and you should place it where you plan to start the vehicle
from. It has no actual impact on flying the mission. The actual home position of a vehicle is set by
the vehicle itself when arming.

This section allows you to set the Altitude and Set Home to Map Centre (you can move it
to another position by dragging it on the map).

Camera

The camera section allows you to specify a camera action to take, control the gimbal and
set your camera into photo or video mode.

Camera

Take photo

| [ Mode

cammands will ke affect
y Upan misson start

The available camera actions are:

e No change (continue current action)
e Take photos (time)

» Take photos (distance)

e Stop taking photos

e Start recording video

» Stop recording video

Vehicle Info

The appropriate mission commands for the vehicle depend on the firmware and vehicle
type.

If you are planning a mission while you are connected to a vehicle the firmware and vehicle

type will be determined from the vehicle. This section allows you to specify the vehicle

firmware/type when not connected to a vehicle. DISA



Vehicle Info

Firmware PX4 Pra

Vehicle Multi-Rotor

Hover speed 5.00

The additional value that can be specified when planning a mission is the vehicle flight
speed. By specifying this value, total mission or survey times can be approximated even

when not connected to a vehicle.

Troubleshooting

Mission (Plan) Upload/Download Failures

Plan uploading and downloading can fail over a noisy communication link (affecting
missions, GeoFence, and rally points). If a failure occurs you should see a status message
in the QGC Ul similar to:

Mission transfer failed. Retry transfer. Error: Mission write mission count failed, maximum

retries exceeded.

The loss rate for your link can be viewed in Settings View > MAVLink. The loss rate should

be in the low single digits (i.e. maximum of 2 or 3):

« Aloss rate in the high single digits can lead to intermittent failures.

» Higher loss rates often lead to 100% failure.

There is a much smaller possibility that issues are caused by bugs in either flight stack or
QGC. To analyse this possibility you can turn on Console Logging for Plan

upload/download and review the protocol message traffic.

Further Info
« New Plan View features for QGC release v3.2 DISA v
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Plan View - GeoFence

GeoFences allow you to create virtual regions within which the vehicle can fly, or in which
it is not allowed to fly. You can also configure the action taken if you fly outside permitted

areas.

Azimuth: 289 Distance: 142.1m i ce: 142 m Max telem dist: 142 m
Heading: 289 = 00:00:45

e =
= @ Mission O Fence @ Rally

GeoFence

G a virtual fence’

around fiy in.

/| Insert GeoFence
Polygon Fence

Circular Fence

Polygon Fences
Inclusion Edit Delete

@] ® Del
[ | [ ] Del

Circular Fences
Inclusion Edit Radius Delete

O (o8 182.8 m Del

INFO

ArduPilot users: GeoFence support is only supported by Rover 3.6 and Copter 3.7 or higher. It also
requires usage of a Daily build or Stable 3.6 (once available). QGroundControl will not display the

GeoFence options if they are not supported by the connected vehicle.

]



Create a Geofence
To create a GeoFence:
1. Navigate to the Plan View

2. Select the Geofence radio button above the Mission Command List

@ Mission O Fence @ Rally

>
7 S

GeoFence
GeoFencing wol 10 st & virtual fenca'

around the a ol want o iy in.

Insert GeoFence

.

Circular Fence

Polygon Fences
Inclusion Edit

a (o]

Circular Fences

MNone

3. Insert a circular or polygon region by pressing the Circular Fence or Polygon Fence
button, respectively. A new region will be added to the map and to the associated list of

fences below the buttons.

TIP

You can create multiple regions by pressing the buttons multiple times, allowing complex geofence

definitions to be created.

e Circular region:



@ Mission O Fence @ Rally

7|
GeoFence

GenFencing allowe you 10 2ot & virtusl fence'
around the ams you want o fly in.

Insert GeoFence

5 Polygon Fence
Irchelpark: \ ;
Circular Fence

Polygon Fences

MNone

Circular Fences

Inclusion Edit Radius Delete

Fl

» Move the region by dragging the central dot on the map

» Resize the circle by dragging the dot on the edge of the circle (or you can change the

radius value in the fence panel).

» Polygon region:

@ Mission O Fence @ Rally

Wi
GeoFence

GanFencing allows you to set a virual fence’
around the area you want to fiy in,

Insert GeoFence

' Polygon Fence
irchelpark 3 i
Circular Fence

Polygon Fences

Inclusion Edit Delete

a O Del

Circular Fences

Maone

e Move the vertices by dragging the filled dots




o Create new vertices by clicking the "unfilled" dots on the lines between the filled
vertices.

1. By default new regions are created as inclusion zones (vehicles must stay within the
region). Change them to exclusion zones (where the vehicle can't travel) by unchecking
the associated Inclusion checkbox in the fence panel.

Edit/Delete a GeoFence

You can select a geofence region to edit by selecting its Edit radio button in the GeoFence

panel. You can then edit the region on the map as described in the previous section.

Regions can be deleted by pressing the associated Del button.

Upload a GeoFence

The GeoFence is uploaded in the same way as a mission, using File in the Plan tools.

Remaining tools

The rest of the tools work exactly as they do while editing a Mission.
Edit on GitHub
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Plan View - Rally Points

Rally Points are alternative landing or loiter locations. They are typically used to provide a
safer or more convenient (e.g. closer) destination than the home position in Return/RTL

mode.

INFO

Rally Points are only supported by ArduPilot on Rover 3.6 and Copter 3.7 (or higher). PX4 support
is planned in PX4 v1.10 timeframes. It also requires usage of a Daily build or Stable 3.6 (once
available). QGroundControl will not display the Rally Point options if they are not supported by the
connected vehicle.

5 ; Tzl Mission
Alt di m Azimuth: 289 Distance: 142.1m Distance: 142 m Max telem disz 192 =
Gradient: 34 % Heading: 289 Time: 00:00:45
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= Rally Points

File | 1 F 3 4 r e allermate landing paints when
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{

N () A - "% | Click in the map to add new rally
1'.!".«';1,—';-:.in'. 4, e points.
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Rally Point Usage
To create Rally Points:

1. Navigate to the Plan View
2. Select the Rally radio button above the Mission Command List
3. Click the map wherever you want rally points.

e An R marker is added for each

» the currently active marker has a different colour (green) and can be edited using the
Rally Point panel.

4. Make any rally point active by selecting it on the map:

» Move the active rally point by either dragging it on the map or editing the position in
the panel.

o Delete the active rally point by selecting the menu option on the Rally Point panel

MET T 8.5524337 3

!
Latiude: EEAEEFELE] '

< Altitude:

Upload Rally Points

Rally points are uploaded in the same way as a mission, using File in the Plan tools.

Remaining tools

The rest of the tools work exactly as they do while editing a Mission.

Edit on GitHub
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Pattern

The Pattern tools (in the PlanView Plan Tools) allow you to specify complex flight patterns
using a simple graphical Ul. The available pattern tools depend on the vehicle (and support

for the vehicle-type in the flight stack).

File Widgets

d Azimuth:
Gradient: -. Heading:

-t

Create complex pattern:

Survey
Corridor Scan
Structure Scan

Fixed Wing Landing

-

Tayioriss

=

Pattern Description Vehicles
Create a grid flight pattern over a polygonal area.
You can specify the polygon as well as the specifications for Al

Surve
Y the grid and camera settings appropriate for creating

eotagged images.
g g9 g [m



Pattern

Structure

Scan

Corridor

Scan

Fixed Wing
Landing

Edit on GitHub

Previous page
Rally Points

Description

Create a grid flight pattern that captures images over
vertical surfaces (polygonal or circular).

These are typically used for the visual inspection or creation
of 3D models of structures.

Create a flight pattern which follows a poly-line (for

example, to survey a road).

Add a landing pattern for fixed wing vehicles to a mission.

Vehicles

MultiCopter,
VTOL

All

Fixed Wing

Next page
Survey
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Survey (Plan Pattern)

A survey allows you to create a grid flight pattern over a polygonal area. You can specify
an arbitrary polygon, the angle and other properties of the grid, and camera settings

appropriate for creating geotagged images.

WARNING

If the survey area has significant elevation variation then consider enabling Terrain Following.

When planning a Survey using camera specifications, the ground under the survey area are
assumed to be flat - i.e. at the same altitude as the launch/home location. If the ground elevation
under the survey is either higher or lower than the home location the effective overlap in images
will be less or more (respectively) than calculated. If ground elevation under the survey area is
significantly higher than the home location you could inadvertently plan a mission path that causes
the vehicle to fly into ground-level obstacles.

Using terrain following ensures that the survey more closely matches the desired altitude above
terrain, and reduces the likelihood of planning a mission that is too close to ground level.
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Creating a Survey
To create a survey:

1. Open PlanView Plan Tools.
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2. Choose the Pattern Tool from the Plan Tools and then select Survey.
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Create complex pattern:

Corridor Scan

Structure Scan

L=
o
Py
This will add a survey grid to the map, and a Survey item to the mission list (on the
right).
3. On the map drag the vertices to change the shape of the polygon.

4. Click the (+) symbol between existing vertices to create a new vertix. The new vertix

can then be dragged into a new position.

The survey settings are covered in the next section.

Settings

The survey can be further configured in the associated mission item (in the mission item
list on the right hand side of the Plan View).

Camera

Camera triggering behaviour depends on the camera/camera settings. You can select an
existing camera, custom camera, or manually enter the settings. The list of available

cameras (QGC 3.4) is given below.

e



| Camera

Sony NEX-5R 20mm

Manual (no camera specs)

Custom Camera

Sony NEX-5R 20mm

Sony ILCE-QX1

Canon 5100 PowerShot
Canon G9 X FowerShat
Canon SX260 HS PowerShot
Canon EDS-M 2Zmm

Sony ag000 16mm

Sony RX100°T 28mm

Ricoch GR II

RedEdge

Farrot Sequioa RGB

Parrot Sequioa Monochrome
GoPro Hero 4

Sentera NDVI Single Sensdr

Known Camera

Selecting a known camera from the option dropdown generates a grid pattern based on
the camera capabilities.

Camera

Sony NEX-5R 20mm

O landscape @ Portrait
Front Lap Side Lap

Select one;

@ Attitude 1058.62

© Ground Res iR am/px

The default settings can be tuned for your survey using the configuration options:

e Landscape/Portrait - Camera orientation relative to the "normal" orientation of the
vehicle.

e Overlap - Overlap between each image capture. This can be configured separately for
when flying along grid lines or across them.

e Select one of: DISA v



o Altitude - Survey altitude (ground resolution will be calculated/displayed for this
altitude).

e Ground resolution - Ground resolution for each image (altitude required to achieve
this resolution calculated and shown).

Custom Camera

Selecting the custom camera option allows you to specify the settings for a new camera in

a similar way to a known camera.

Camera

Custom Camera

Q© Landscape @ Portrait
Width Height

Image [Elily px § 3000 px
2

Front Lap Side Lap

Select one:
@ Attide | 684.21 "

The camera-specific settings are:

o Sensor width/height - The size of the image sensor of the camera.
+ Image width/height - The resolution of the image captured by the camera.

e Focal Length - The focal length of the camera lens.

The remaining settings are the same as for a known camera.

Manual Camera

The manual camera option allows you to specify desired survey height, trigger interval and

appropriate grid spacing for your camera.

]



Camera

Manual (no camera specs)

Altitude 684.21
Trigger Distance kiRl

Spacing 300.00

The configurable options are:

o Altitude - Survey altitude to fly the whole grid.

» Trigger Distance - The distance over ground between each camera shot.

e Spacing - Distance between adjacent grid (flight path) lines across the corridor.

Transects

The Transects section is used for grid settings that are independent of the camera used.

Transects

Angle deg
’_‘\\:'
(5

Turnaround dist R m

Rotate Entry Point

. Hover and capture image
B Refly at 90 deg offset
B images in turnarounds

The configurable options are:

e Angle - The angle of the grid lines, relative to North.
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Rotate Entry Point
tiw

ﬁ B Hover and capture image
| Il Refly at 90 deg offset
B Images in turnarounds
. -
Thofnbury
| Terrain

Turnaround dist - Amount of additional distance to add outside the survey area for
vehicle turn around.

Rotate Entry Point - Press button to swap the start and end point of the survey.

Hover and capture image - Hover to capture images (multicopter only).

Refly at 90 degree offset - Check to refly the whole mission at a 90 degree offset.

e Images in turnarounds - Check to take images when turning

« Relative altitude - Check to make specified altitudes relative to home (if unchecked
they are AMSL).

Terrain

By default, a flying vehicle will follow the survey path at a fixed altitude. Enabling Terrain

e

Following makes the vehicle maintain a constant height relative to ground.



Terrain

Vehicle follows terrain

Tolerance 10.00
Max Climb Rate 0.00

Max Descent Rate QiR

INFO

Terrain following uses terrain heights queried from AirMap servers.

The configurable options are:

» Vehicle follows terrain - Check to enable terrain following (and display the following
options).
» Tolerance - The accepted deviation in altitude from the target altitude.

» Max Climb Rate - Maximum climb rate when following terrain.

» Max Descent Rate - Maximum descent rate when following terrain.

Statistics

The Statistics section shows the calculated survey area, photo interval, photo spacing and

planned photo count.

Statistics

Survey Area 3170773.58 m™2

Photo Count 38
Photo Interval 49.0 secs
Trigger Distance 244.80 m

Edit on GitHub

Previous page Next page
Pattern Structure Scan
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Menu On this page

Structure Scan (Plan Pattern)

A Structure Scan allows you to create a grid flight pattern that captures images over
vertical surfaces (e.g. walls) around a structure with an arbitrary polygonal (or circular)
ground footprint. Structure Scans are typically used for the visual inspection or creating 3D

models of structures.

Structure Scans may be inserted into a mission using the Plan view Pattern > Structure

Scan tool.

INFO

The new version of Structure Scan can't read older Structure Scan plans. They will need to be

recreated.

WARNING

This feature is not yet supported by ArduPilot firmware. It is supported in PX4.

Overview

The image below shows a screenshot of structure scan. The green polygon is used to mark
out the ground footprint of the structure, while the white line around it indicates the
vehicle flight path. The green numbered circle on the flight path is the scan entry/exit point

(where the scan starts).



File Widgets

Distance: 0.0 m nce: n Max telem dis
Time: 00

Q Mission @ Fence @ Rally

P Mission Start

Manual (no camera specs) *
Scan Distance  eieisl] m
Layer Height 10.00 m

Trigger Distance JEESS] m

Start Scan From Bottom hd
Structure Height gSiuy m
Scan Bottom Alt
Entrance/Exit Alt =AY

Gimbal Pitch o] deg

Rotate entry point

Height 10.00 m
Top Layer Alt 45.0m

Bottom Layer Alt 5.0 m
a = 750

The scan divides the structure evenly into layers; the vehicle flies all the way around the
structure at a particular altitude and scan distance from the structure, then repeats the

process at each layer until the whole surface has been scanned.



Structure height

~ Scan bottom altitude

Users can set the scan bottom altitude to avoid obstacles at the bottom of the structure,
and the extrance/exit altitude to avoid obstacles as the vehicle travels to/from the scan.

Creating a Scan

To create a scan:

1. In the Plan View select Pattern tool > Structure Scan.
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Azimuth: 0 Distance: 0.0m 5 0 Max telem dist: 226 m
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O Mission @ Fence @ Rally

esen s structune surface not
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Manual (o camera specs)

Scan Distance

Layer Height 9.87

Trigger Distance BEBE]
| Scan

M start Scan From Top

I

Structure Height VRE]
Scan Bottom Alt

Entrance/Exit Alt

&

Gimbal Pitch

Rotate entry point

Statistics

The region shown in green must be modified so that it surrounds the structure.

» Drag the opaque vertices on the map to the edge of the structure (example circled in

mauve above).
DISA v



« If the structure footprint is more than a simple square you can click the semi-
transparent circles between the vertices to create a new vertix.

2. You can also change to a circular footprint by clicking on the central "vertix" (marked in

red) and selecting Circle in the popup menu.

Polygon

Set radius...
tdit position...
Load KML/SHP..

« From the popup menu you can switch back to a polygon footprint and change the
radius and/or position of the scan.

» Drag the central vertix to position the centre of the circle.

3. The rest of the configuration is handled using the Structure Scan editor on the right
hand side of the view. First select whether you want to perform a manual scan, a scan

using a particular camera, or a scan using a custom camera definition.
INFO

The main difference between the modes is that predefined cameras are already set up to

correctly calculate an effective layer height and trigger distance.

Options for the different modes are shown below. DISA v



ote: Polygon respressnis structure surface not
vehicle Might path.

Camera

Manual (no camera specs) n

Scan Distance

Layer Height

Trigger Distance ERF

Scan

Start Scan From Top -

Structure Height IHIRCH

Scan Bottom Alt JS{EKN]

Entrance/Exit Alt

Gimbal PFitch

Rotate entry point

Statistics

Layers 9

Layer Height 6.08 m
Top Layer Alt 97.0 m
Bottom Layer Alt 48.3 m
Photo Count 738
Photo Interval 2.6 secs
Trigger Distance 9.12 m

veh lr: I'Iuhl |.'|_11.f|
Camera

Canon EOS-M 22mm -

Q landscape @ Porirait
Front Lap Side Lap

Select one:

@ Ground Res
Scan

Start Scan From Top

Structure Height BIEiEu1]

Scan Bottom Alt

Entrance/Exit Alt

Rotate entry point

Statistics

Layers g

Layer Height 6.08 m
Top Layer Alt 97.0m
Bottom Layer Alt 48.3 m
Photo Count 738
Photo Interval 2.6 secs
Trigger Distance 9.12 m

The user can always configure the following settings:

Top Layer Alt

| respresents sruchure surface not
viehicle flight path.

Camera

Q landscape @ Portrait
Width Height

Front Lap Side Lap

Select one:

@ Ground Res

Scan

Start Scan From Top

Structure Height BICiKE]

Scan Bottom Alt iR
Entrance/Exit Alt m

Rotate entry paint

Statistics

Layers 9

Layer Height 6.08 m
97.0m
Bottom Layer Alt 48.3 m
Photo Count 738
Photo Interval 2.6 secs
Trigger Distance 9.12 m

Start scan from top/bottom: The direction in which layers are scanned.

Structure height: The height of the object being scanned.

Scan distance: Distance from the structure to the flight path.

Entrance/Exit Alt: Use this setting to avoid obstacles between the last/next waypoint
and the structure to be scanned.

e The vehicle will fly to the Entrance/Exit point at this altitude and then descend to the
initial layer to start the scan.

]



o The vehicle will ascend to this altitude after completing the scan and then move to
the next waypoint.

o Scan Bottom Alt: Use this setting to avoid obstacles around the base of the structure.
This adjust the bottom of the structure to be above the ground, and hence the altitude
of the first scan (the height of the lowest layer flight path is shown in the scan statistics
as Bottom Layer Alt.

o Rotate Entry Point: Move the start/finish point to the next vertix/position on the flight
path.

The remaining settings depend on the camera mode:

e Manual Mode allows you to specify:

» Layer height: The height of each layer.

o Trigger Distance: The distance between each camera trigger. The camera is only
triggered while flying the layer path. It does not trigger images while transitioning
from one layer to the next.

e Gimbal Pitch - Gimbal pitch you want to use for the scan.

» Known/pre-defined cameras automatically calculates layer heights and image triggering
from required image overlap, and allows you to trade off scan distance and require
image resolution. It also ensures that the camera is pointed directly at the surface when

it is capturing images (i.e. at a right angle rather than some tangent). The settings are:

o Camera Orientation: Portrait or Landscape

e Overlap:

e Front Lap: Image overlap from top to bottom (increasing shrinks layer height and
increases layer count).

» Side Lap: Image overlap at sides (increasing takes more images in each lap/layer
scan).

e Scan distance: Distance from the structure to the flight path.

e Ground Res: Required image resolution/sample quality of surface.

o Custom camera selection allows you to enter your own camera characteristics, but

otherwise behaves the same as a predefined camera.

]
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Corridor Scan (Plan Pattern)

A corridor scan allows you to create a flight pattern that follows a poly-line. This can be

used to, for example, survey a road. It is supported on all autopilots and vehicle types.

Important When planning a Corridor Scan using camera specifications the ground
elevations under your survey area are assumed to be at the same altitude as your
launch/home location. If the ground elevation under your survey area is either higher or
lower than your launch/home location the effective overlap in your images will be less or
more (respectively) than calculated. If ground elevation under your survey area is
significantly higher than your launch/home location you could inadvertently plan a
mission which causes the vehicle to fly into trees, obstacles, or the ground. Use Terrain
Follow to create a survey that more closely maintains the desired altitude above terrain

that has significant elevation differences from your launch/home altitude.
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You can specify the path, the width of the corridor, and camera settings appropriate for

creating geotagged images.

Creating a Scan
To create a corridor scan:
1. Open PlanView Plan Tools.

2. Choose the Pattern Tool from the Plan Tools and then select Corridor Scan.



Create complex pattern:

Waypaoint

Survey
E Corridor Scan

Pattarn
Struckure Scan

This will add a corridor to the map, and a Corridor Scan item to the mission list (on the
right).

3. On the map drag the ends of the corridor to the start and end positions of the scan,

respectively.

4. Click the (+) symbol at the centre of a line to create a new vertix. The new vertix can

then be dragged into position to follow the path of the desired corridor.

The corridor scan settings are covered in the next section.

Settings

The corridor scan can be further configured in the associated mission item (in the mission

item list on the right hand side of the Plan View).

Camera



Camera triggering behaviour depends on the camera/camera settings. You can select an

existing camera or manually enter the settings. The list of available cameras (QGC 3.4) is

given below.

Canon SX260 HS PowerShot

Manual {no camera specs)

Custom Camerd
any NEX-5R 20mm
ony ILCE-QX1

Canon 5180 Powershot

| Canon G9 X PowerShot

Canon SX260 HS PowerShot

| Canon EOS-M 22mm
Sony a6000 16mm
| Sony RX100 I 28mm
Ricoh GR I
RedEdge
Farrot Seguica RGB
Parrot Sequica Monochrome
GoPro Hero 4
Sentera MDVI Single Sensor

Sentera Double 4K Sensor
Terrem =

Known Camera

Selecting a known camera from the option dropdown allows you to generate a grid pattern

based on the camera's specifications.

Camera

Canon SX260 HS Powershot

ﬂ Landscape . Portrait
Front Lap Side Lap

Select one:

@ 2ltitude 729,34 m

© Ground Res kgl om/px

The configurable options are:



e Landscape/Portrait - Camera orientation relative to the "normal" orientation of the
vehicle.

e Image Overlap - Overlap between each image.
e Select one of:

o Altitude - Survey altitude (ground resolution will be calculated/displayed for this
altitude).

e Ground resolution - Ground resolution for each image (altitude required to achieve
this resolution calculated and shown).

Manual Camera

The manual camera option allows you to specify desired survey height, trigger interval and

appropriate grid spacing for your camera.

Camera

Manual (no camera specs)

Aldtude 10.00
Trigger Distance JsRil

Spacing 100.00

The configurable options are:

o Altitude - Survey altitude.
» Trigger Distance - The distance over ground between each camera shot.

e Spacing - Distance between adjacent grid (flight path) lines across the corridor.

Corridor

Corridor

Width 500.0 m
Turnaround dist R m

Take images in turnarounds

]
Rotate Entry Point

The configurable options are:



e Width - Set the width of the scan around the polyline that defines the path.

e Turnaround dist - Amount of additional distance to add outside the survey area for
vehicle turn around.

» Take images in turnarounds - Check to enable image capture a turnaround points.

» Relative altitude - Check to specify a relative altitude. This is only supported for manual
grids that are not using terrain following.

« Rotate entry point - Press button to swap the start and end point of the corridor scan.

Terrain Following

By default a flying vehicle will follow the corridor path at a fixed altitude. Enabling Terrain

Following makes the vehicle maintain a constant height relative to ground.

Terrain

I vehicle follows terrain

Tolerance 10.00
Max Climb Rate 0.00

Max Descent Rate giRis

INFO

Terrain following uses terrain heights queried from AirMap servers.

The configurable options are:

» Vehicle follows terrain - Check to enable terrain following (and display the following
options).
» Tolerance - The accepted deviation in altitude from the target altitude.
» Max Climb Rate - Maximum climb rate when following terrain.

» Max Descent Rate - Maximum descent rate when following terrain.

Statistics

The Statistics section shows the calculated survey area, photo interval, photo spacing and

planned photo count.

]



Statistics

Survey Area 3499357.94 mA2

Photo Count 1420
Photo Interval 5.0 sers
Trigger Distance 25.00 m

Edit on GitHub
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Structure Scan
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Fixed Wing Landing Pattern (Plan Pattern)

The Fixed Wing Landing Pattern tool allows you to add a fixed wing landing pattern to a

mission. It is supported on both ArduPilot and PX4.

File Widgets
-10.0 m Azimuth: 250 Distance: 183.6 m ) Max telem dist 234 m
" Heading: 250
- B Mission R
o [ Yies
P Mission Start

Altitude
Radius
Loiter clockwise

Landing point

1 Heading
| Altitude
"8 © Landing Dist

| @ Glide Slope | 10.2

Altitudes relative to home

The first point of the pattern is a loiter point with a specific altitude and the second is a
landing point. The vehicle will loiter at the first point until it reaches the target altitude, and

then begin the landing sequence to fly down to the specified landing spot.

Both the loiter and land points can be dragged to new positions, and a number of other

settings can be configured in the associated mission item.

]



Creating a Landing Pattern
To create a landing pattern:
1. Open PlanView Plan Tools.

2. Choose the Pattern Tool from the Plan Tools and then select Fixed Wing Landing
Pattern.

i Create complex pattern: ¥

!
Survey

Corridor Scan

Tl ——
L .

L Fyffa st
)

This will add a Landing Pattern item to the mission list (on the right).

*O Missian . Fence . Rally

P Mission Start

3. Click on the map to create both the loiter point and the landing point. These can be

]

moved on the map.



Additional settings are covered in the next section.

Settings

The landing pattern can be further configured in the associated mission item (in the
mission item list on the right hand side of the Plan View).

Loiter Point

The Loiter Point settings are used to configure the loiter altitude, radius and direction.

Loiter point

oo T

Loiter clockwise

The configurable options are:

o Altitude - Loiter altitude.
e Radius - Loiter radius.

o Loiter clockwise - Check to loiter in a clockwise direction (anti-clockwise is the default).

Landing Point
The Landing Point settings are used to configure the landing position and path.
Landing point

Heading deg

O g

@ Giide Siope | 10.2 deg|

P Altitudes relative to home



The configurable options are:

Heading - Heading from loiter point to land point.

Altitude - Altitude for landing point (nominally zero).

Radio Buttons

e Landing Dist - Distance between loiter point and landing point.

o Glide Slope - Glide slope between loiter point and landing point.

Altitudes relative to home - Check to set all altitudes in mission item to be relative to
home (default is AMSL).

Implementation
This pattern creates three mission items:

e DO_LAND_START - If you abort a landing it sends Do_Go_AROUND to the vehicle, which then
causes the mission to return to this point and try to land again.

e NAV_LOITER_TO_ALT - Start point for landing

e NAV_LAND - End point for landing

The vehicle flares to landing using a flight path generated by the firmware between the
NAV_LOITER_TO_ALT point and the NAV_LAND point.

If those two locations violate the vehicle's flare constraints (e.g. descent angle is too

steep) an error will be raised after you upload the invalid mission to the vehicle.

INFO

On PX4, violating the flare constraints sends an error message to the ground station at upload
time, and the autopilot will refuse to start the mission (since it fails integrity checks).

Edit on GitHub
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Plan View - Pattern Presets

Allows you to save commonly used settings as a named preset.

INFO

Currently only supported by Survey. Support for other Patterns is in development.

Managing Presets

Custom (specify all settings) =

v Custom (specify all settings)
Save Settings As Preset
Delete Current Preset ¥
Presets:
Max Height NDVI
No Saved Camera
b v - T 7

Pattern items have a new selection at the top which allows you to manage presets:

e Custom (specify all settings) This allows you to not use a preset and specify all settings
manually.

» Save Settings As Preset Saves the current settings as a named preset.

e Delete Current Preset Deletes the currently selected preset.

e Presets: Below this item will be listed the available presets for this pattern.

Creating/Updating A Preset (osa_



Save Preset Cancel

Save the current settings as a named preset.

Preset Name

Save Camera In Preset

When you select Save Settings As Preset you will be prompted for the preset name. To
save new settings for an existing preset select Save Settings As Preset while a preset is

currently selected.

You can also specify whether you want to save the currently selected camera in the
preset. If you choose not to save the camera with the preset then the current camera will
be used when loading the preset. You will also be able to change to a different camera
when using the preset. Unless you fly your vehicle with different cameras at different times

with the same preset you should select to save the camera in the preset.

Viewing Preset Settings

If you want to view what the exact settings are for a Preset switch back to Custom
(specify all settings) which will show you all the settings. Then you can switch back to

using the named preset when done.

Presets In A Plan File

The currently selected Preset is also saved in the Plan file such that when you load the
Plan back the preset will once again be selected. Keep in mind that presets are specific to
your version of QGroundControl. If you share a Plan file with a preset with another user,
incorrect behavior may occur if that other user also has a preset of the same name but
different settings.

]
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Menu

Setup View

On this page

The Setup View is used to configure a new vehicle prior to first flight and/or tune a

configured vehicle.

0
x:' 100.0 [ = ||E E

Manual

B e

Firmware

Airframe

System ID: 1
Airframe type: Quadrotor x
Vehicle: CGeneric 250 Racer
Firmware Version: Unknown

Alrframe
Radio
Sensors
Flight Modes
Sensors

Power Compass 0:

Compass 1,

Compass 2:

Safety Gyro
Accelerometer:

Tuning
Camera

Parameters

Battery Full: 4.05V
Battery Empty: 340V

Number of Cells: 3

Setup Options

Roll:
Pitch:
Yaw:
Throttle:
Flaps:
Auxl
Aux2:

Mode switch:
Flight Mode 1
Flight Mode 2
Flight Mode 3 :
Flight Mode 4 :
Flight Mode 5
Flight Mode &

RTL min alt:
RTL home alt:
RC loss RTL:

RC loss action:
Link loss action:

Low battery action:

Below you will find a summary of the settings for your vehicle. To the left are the setup menus for each component.

Radio

Setup required

2
Disabled
Disabled
Disabled

Flight Modes

Channel 5
Stabilized
Unassigned
Unassigned
Position
Unassigned
Altitude

30.0m
10.0 m
0.5s
Disabled
Disabled
Warning

To the left of the screen are the set of available setup options. A setup button is marked
with a red icon if there are still settings needed to be adjusted/specified. You shou[Ld_uo.LLAﬁ

DISA_



if any of these are red. In the above image the Radio setup is not yet complete.

INFO

The set of options shown and the contents of each option may differ based on whether the vehicle
is running PX4 Pro or ArduPilot firmware. The image above is from a vehicle which is running PX4
Pro firmware.

Summary
An overview of all the important setup options for your vehicle. Similar to the individual
setup buttons, the summary blocks show a red indicator when those settings are not fully

configured.

Firmware

Flash new firmware onto your vehicle.

Airframe

Specify the airframe type for the vehicle.

Radio

Calibrate your Radio Control Transmitter.

Sensors

Calibrate the sensors on the vehicle.

Flight Modes

Used to assign flight modes to your RC Transmitter switches.

Power

Battery settings and additional power options such as ESC calibration.

Motors

Motors testing and setup.

Safety

Specify settings for options related to Safety such as Return to Home or Failsafes.

Tuning

Tune flight characteristics of the vehicle.

]



Camera
Configure settings for camera and gimbal.

Parameters
Allows you to modify all parameters associated with your vehicle.

Edit on GitHub
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Loading Firmware

QGroundControl desktop versions can install PX4 Pro or ArduPilot firmware onto Pixhawk-

family flight-controller boards. By default QGC will install the current stable version of the
selected autopilot, but you can also choose to install beta builds, daily builds, or custom

firmware files.
QGroundControl can also install the firmware for SiK Radios and PX4 Flow devices.

Caution Loading Firmware is currently not available on tablet or phone versions of
QGroundControl.

Connect Device for Firmware Update

Caution Before you start installing Firmware all USB connections to your vehicle must
be disconnected (both direct or through a telemetry radio). The vehicle must not be
powered by a battery.

1. First select the Gear icon (Vehicle Setup) in the top toolbar and then Firmware in the
sidebar.
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Summary

& Firmware
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QGroundCentrol can upgrade the firmware on Pixhawk devices, Sik Radios and PX4 Flow Smart Cameras.
e via USB o firmware upgrade.

1. Connect your device (Pixhawk, SiK Radio, PX4 Flow) directly to your computer via USB.

INFO

Connect directly to a powered USB port on your machine (do not connect through a USB hub).

Select Firmware to Load

Once the device is connected you can choose which firmware to load (QGroundControl

presents sensible options based on the connected hardware).

1. For a Pixhawk-compatible board choose either PX4 Flight Stack vX.X.X Stable Release

or ArduPilot Flight Stack radio buttons to download the current stable release.
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Vehicle Setup Firmware Setup Cancel ﬂ

Summary .
Detected Pixhawk board. You can select from the
following flight stacks:

-“l‘ Fi
rmware
peineve YGroundControl ca wde the firmvare ichawk devices. SiK Radios and PX4 Elow Smart © PX4 Flight Stack v1.8.0 Stable Release

@ Ardupilot Flight Stack

— M Advanced settings

If you select ArduPilot you will also have to choose the specific firmware and the type of

vehicle (as shown below).

Firmware Setup Cancel

Detected Pixhawk board. You can select from the
following flight stacks:

@ PX4 Flight Stack

© ArduPilot Flight Stack

MultiRator - APM:Capter V3.5.7

MultiRotor — APM: Copter V3,5.7
Hell - APM:Copter V3.5.7
ArduPlane V3.9.1

ArduRover V3.4.2

Sub - ArduSub ¥3.5.3

2. Check Advanced settings to select specific developer releases or install firmware from

your local file system.



Firmware Setup

Detected Pixhawk board. You can select from the
following flight stacks:

@ PXa4 Flight Stack v1.8.0 Stable Release

© ArduPilot Flight Stack
MultiRotor - APM:Copter V3.5.7

— I Advanced settings

Select which version of the above flight stack you
would like to install:

Standard Version (stable)

Standard Version (stable)

Beta Testing (beta)

Developer Build {master)
| Customn firmware file...

Update the firmware
1. Click the OK button to start the update.

The firmware will then proceed through a number of upgrade steps (downloading new
firmware, erasing old firmware etc.). Each step is printed to the screen and overall

progress is displayed on a progress bar.
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Vehidle Setup

Summary

FIRMWARE

on Pixhawk devices, SiK Radios and PX4 Flow Smart Cameras.

QGroundControl can upgrade the firmw

2 amazonat
Download complete
MAV_AUTOPILOT =12
d parametar_xml
frame_xml
ully decompr: d image
Erasing previous program...
Erase complete
Programming new version...
Program complete
Verifying program...
Verify complete
mplete

stable/px4fmu-v2_default. pxd

Once the firmware has finished loading the device/vehicle will reboot and reconnect. Next

you will need to configure the airframe (and then sensors, radio, etc.)

Edit on GitHub

Previous page

Vehicle Setup

Next page
Airframe
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Menu On this page

Radio Setup

Radio Setup is used to configure the mapping of your main transmitter attitude control
sticks (roll, pitch, yaw, throttle) to channels, and to calibrate the minimum, maximum, trim

and reverse settings for all other transmitter controls/RC channels.

The main calibration process is identical for PX4 and ArduPilot (a number of additional

flight-controller specific settings/tools are detailed below).

INFO

Before you can calibrate the radio system the receiver and transmitter must be connected/bound.
The process for binding a transmitter and receiver pair is hardware specific (see your manual for

instructions).

Performing the Calibration

The calibration process is straightforward - you will be asked to move the sticks in a
specific pattern that is shown on the transmitter diagram on the top right of the screen.

Simply follow the instructions to complete calibration.

To calibrate the radio:

1. Select the Gear icon (Vehicle Setup) in the top toolbar and then Radio in the sidebar.
2. Turn on your RC transmitter.

3. Press OK to start the calibration.
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Vehicle Setup Radio SEtLi[J

Summary Radio Setup is used to calibrate your transmitter. It also assign channels for Rall, Pitch, Yaw and Throttle vehicle control as well as determining whether they are reversed.

Attitude Contrals

Firmware £l

Pitch
Airframe
Yaw

Throttle

Sensors
Flight Modes
Power

Safef
kil Additional Radio setup:

Tuning

Camera

AUX1 Passthrough RC Channel:
Parameters

AUX2 Passthrough RC Channel:

PARAM1 tuning channel:

PARAM?2 tuning channel:

PARAM3 tuning channel:

INFO

Manual

Not Mapped
Not Mapped
Not Mapped

Not Mapped

Radic

X

Cancel m

Before calibrating you should zero all your trims
and subtrims. Click Ok to start Calibration.

The image above is for PX4 Pro. Calibration/top section is the same for both firmware, but the

Additional Radio setup section will differ.

4. Set the transmitter mode radio button that matches your transmitter configuration (this

ensures that QGroundControl displays the correct stick positions for you to follow

during calibration).

Radio Setup

Radio Setup is used to calibrate your transmitter. It also assign channels for Rall, Pitch, Yaw and Throttle vehicle control as well as determining whether they are reversed.

Attitude Controls
Roll

Pitch

Sl

Lower the Throttle stick all the way down as shown in diagram.

It is recommended to disconnect all motors for additional safety, however, the system is designed to not arm during the calibration.

Click Next to continue

Additional Radio setup:

Not Mapped
Not Mapped
Not Mapped

Not Mapped

@ Mode 1 Q) Mode 2

Channel Manitor

@ NG ! B W N e

5. Move the sticks to the positions indicated in the text (and on the transmitter image).

Press Next when the sticks are in position. Repeat for all positions.

]



6. When prompted, move all other switches and dials through their full range (you will be

able to observe them moving on the Channel Monitor).
7. Press Next to save the settings.

Radio calibration is demonstrated in the PX4 setup video here (youtube).

Additional Radio Setup

At the lower part of the Radio Setup screen is firmware-specific Additional Radio setup

section. The options for each autopilot are shown below.

PX4 ArduPilot

Additional Radio setup:
Spaktrum Bind

Copy Trims
Additional Radio setup:

AUX1 Passthrough RC Channel: = Unassigned
Spektrum Bind

AUXZ2 Passthrough RC Channel: = Unassigned

PARAM1 tuning channel: | Unassigned

PARAM2 tuning channel: | Unassigned

PARAMS tuning channel: | Unassigned

Spectrum Bind (ArduPilot/PX4)

Before you can calibrate the radio system the receiver and transmitter must be
connected/bound. If you have a Spektrum receiver you can put it in bind mode using
QGroundControl as shown below (this can be particularly useful if you don't have easy

physical access to the receiver on your vehicle).
To bind a Spektrum transmitter/receiver:

1. Select the Spektrum Bind button



2. Select the radio button for your receiver

3. Press OK

|/@ aan 07\o [;,| A o‘gfﬁ ke a4 B Manual

Vehicle Setup Radio Setu p

Radio Setup is used to calibrate your transmitter. It also assign channels for Roll, Pitch, Yaw and

Summary
whether they are reversed.

Attitude Controls

fifoieen Rall Not Mapped

Airframe Pitch Mot Mapped

Yaw Mot Mapped

O Rradio

Not Mapped

Sensors

Flight Modes

Power

Safety

Additional Radio setup:
Tuning

22X

Radio Cancel ﬂ

Click Ok to place your Spektrum receiver in the
bind mode. Select the specific receiver type
below:

@ DSM2 Mode
@ DSMX (7 channels or less)
© DSMX (8 channels or more)

4. Power on your Spektrum transmitter while holding down the bind button.

Copy Trims (PX4)

This setting is used to copy the manual trim settings from your radio transmitter so that

they can be applied automatically within the autopilot. After this

remove the manually set trims.

To copy the trims:

1. Select Copy Trims.

2. Center your sticks and move throttle all the way down.

3. Press Ok.

is done you will need to
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Vehicle Setup

Summary

Firmware

Airframe
D radio

Sensors

Flight Modes

Power

Safety

Tuning

Camera

Parameters

Radio Setup

Radio Setup is used to calibrate your transmitter. It also assign channels for Rall, Pitch, Yaw and
whether they are reversed.

Attitude Controls
Roll Not Mapped

Pitch Not Mapped
Yaw Not Mapped

Throttle Not Mapped

Additional Radio setup:

AUX1 Passthrough RC Channel:

AUX2 Passthrough RC Channel:

4. Reset the trims on your transmitter back to zero.

AUX Passthrough Channels (PX4)

2Xt

R

Radio Cancel m

Center your sticks and move throttle all the way
down, then press Ok to copy trims. After pressing
Ok, reset the trims on your radio back to zero.

AUX passthrough channels allow you to control arbitrary optional hardware from your

transmitter (for example, a gripper).

To use the AUX passthrough channels:

1. Map up to 2 transmitter controls to separate channels.

2. Specify these channels to map to the AUX1 and AUX2 ports respectively, as shown

below. Values are saved to the vehicle as soon as they are set.



AUX1 Passthrough RC Channel: | Unassigned

AUX2 Passthrough RC Channel: JReEHIG=IRES
Channel 11
Channel 10
Channel 13
Una

Channel 12

FARAML tuning channel: NERSS

'I'-‘.'".If.!_l.".‘-'-"! uni g :!-ﬁlnr,:!: Una Chﬂﬂn&f 15

Channe}- 1.

Channel 17

The flight controller will pass through the unmodified values from the specified channels

out of AUX1/AUX2 to the connected servos/relays that drive your hardware.

Param Tuning Channels (PX4)
Tuning channels allow you to map a transmitter tuning knob to a parameter (so that you

can dynamically modify a parameter from your transmitter).

TIP

This feature is provided to enable manual in-flight tuning.

The channels used for parameter tuning are assigned in the Radio setup (here!), while the

mapping from each tuning channel to its associated parameter is defined in the Parameter

editor.
To set up tuning channels:
1. Map up to 3 transmitter controls (dials or sliders) to separate channels.

2. Select the mapping of PARAM Tuning Id to radio channels, using the selection lists.

Values are saved to the vehicle as soon as they are set.



Additional Radio setup:

Spektrum Bind

Copy Trims
AUX1 Passthrough RC Channel: | Unassigned
AUX2 Passthrough RC Channel: | Unassigned

PARAMI tuning channel: | Unassigned

PARAM2 tuning channel: = Unassigned

FARAM3 tuning channel: | Unassigned

To map a PARAM tuning channel to a parameter:

1. Open the Parameters sidebar.

2. Select the parameter to map to your transmitter (this will open the Parameter Editor).

3. Check the Advanced Settings checkbox.

4. Click the Set RC to Param... button (this will pop-up the foreground dialog displayed

below)
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Vehicle Setup

Summary

Firmware

Airframe

Sensors

Flight Modes

Power

Safety

Tuning

Camera

/%OOKQ@J|A)‘::1?5*‘E-1

Search; |

Component #: 1

Manual

GF_ACTION Warning

GF_ALTMODE
Dialog

WGES84

Bind

Parameter Tuning 1D 1

Tuning IDs can be mapped to channels in the RC settings
Parameter

with

Scale (keep default)

Center value

Minimum Value

Maximum Value

Parameter value is up to date

oK

Geol

Geol

Cancel

Parameter Editor

Max horizontal distance in meters

Maximum horizontal distance in meters the vehide
be from home before triggering a gecfence

action. Disabled if 0.

Reset to default

|GF_MAX_HOR_DIST

Units: m
Minimum value: 0
Maximum value: 10000

Default value: 0

Waming: Modifying values while vehicle is in flight
can lead to vehicle instability and possible vehicle
loss. Make sure you know what you are doing and
double-check your values before Savel

— K8 Advanced settings ———

Set RC to Param...

5. Select the tuning channel to map (1, 2 or 3) from the Parameter Tuning ID selection list.

6. Press OK to close the dialog.

7. Press Save to save all changes and close the Parameter Editor.

TIP

You can clear all parameter/tuning channel mappings by selecting menu Tools > Clear RC to Param

at the top right of the Parameters screen.

Edit on GitHub

Previous page

Airframe (PX4)

Next page
Sensors
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Menu On this page

PX4 Flight Modes Setup

The Flight Modes section allows you to configure which flight modes and other actions are

triggered by particular switches/switch positions on your RC transmitter.

INFO

In order to set up flight modes you must already have

e Configured your radio in order to set flight modes.

e Setup the RC transmitter (Flight Modes > Transmitter Setup)

To access this section, select the Gear icon (Vehicle Setup) in the top toolbar and then
Flight Modes in the sidebar.



Back < g& Vehicle Setup

. Flight Modes Setup
Summary -
Flight Modes Setup is used to configure the transmitter switches associated with Flight Modes.

Flight Mode Settings Switch Settings

Mode Channel | Channel 5 - Arm switch channel Channel 11+ | Landing gear switch channel | Unassi

Flight Mode 1 Emergency Kill switch channel Loiter switch channel

Firmware

Airframe

SersETS Hight Mode 2 Dffboard switch channel Return switch channel

Flight Mode 3
hannel Monitor

C
LT Flight Mode 4 1
5
7

Flight Mode 5
[Ull Flight Modes
Flight Mode &
Power g

1
13

Motors

17 &

Safety

PID Tuning

Parameters

Flight Mode Settings

The screen allows you to specify a "mode" channel and select up to 6 flight modes that will
be activated based on the value sent on the channel. You can also assign a small number
of channels to trigger particular actions, such as deploying landing gear, or emergency

shutdown (Kill switch).
The steps are:
1. Turn on your RC transmitter.

2. Select the Gear icon (Vehicle Setup) in the top toolbar and then Flight Modes in the
sidebar.

]



Back < g{} Vehicle Setup

Flight Modes Setup

Summary
Flight Modes Setup is used to configure the transmitter switches associated with Flight Modes.

Flight Mode Settings Switch Settings

Made Channel Arm switch channel Landing gear switch channel | U

Flight Mode 1

Firmware

Airframe
Emergency Kill switch channel | U = | Loiter switch channel

Hight Mode 2

e Offboard switch channel ~ | Return switch channel

hannel Monitar

C
1

5
7

Flight Mode 5
rUU Flight Modes
Power g

&

13
Motars

17

Safety

PID Tuning

Parameters

3. Specify Flight Mode Settings:
e Select the transmitter Mode channel (shown as Channel 5 above).
e Select up to six Flight Modes for switch positions encoded in the channel.

INFO

Position mode, return mode and mission mode are recommended.

4. Specify Switch Settings:

o Select the channels that you want to map to specific actions - Kill switch, landing
gear, etc. (if you have spare switches and channels on your transmitter).

5. Test that the modes are mapped to the right transmitter switches:

o Check the Channel Monitor to confirm that each switch moves the expected channel.

]



o Select each mode switch on your transmitter in turn, and check that the desired flight
mode is activated (the text turns yellow on QGroundControl for the active mode).

All values are automatically saved as they are changed.

See Also

e PX4 Flight Modes

Edit on GitHub

Previous page Next page
ArduPilot Flight Modes Setup Power
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Menu On this page

Power Setup

The Power Setup screen is used to configure battery parameters and also provide

advanced settings for propellers.

|§] %ﬂ ’\9 [}\ £ 02 o 4 [E100% Hold Disarmed

Vehide Setup Power Setup

Power Setup is used to setup battery parameters as well as advanced settings for propellers.

Battery

Firmware
MNumber of Cells (in Series)
Airframe Full Voltage (per cell) Battery Max: 12.2V
Empty Voltage (per cell} Battery Min: 10.2V
Radio
Voltage divider 10.17793941 Calculate

Sensors I the battery valtaga renorted by the vahicla is largely differant than the voltage read sdermally using 3 valtmater
you can adjust the valage multiplier value o correct this. Oick the Caloulate hutton for help with calculating a
new value,

Summary

Flight Modes Aot Calculate

If the current draw reparted icle ks largely different than the current read externally using a current
Power can adfist the amp salie o correct this, Click the Caleulsts button for help with calculating a

Safety ESC PWM Minimum and Maximum Calibration

Tuning
You must use USB connection for this operation.
Camera
Calibrate

Parameters
B show UAVCAN Settings

B show Advanced Settings

Battery Voltage/Current Calibration

Enter data for your battery/power module from its data sheet: number of cells, full voltage
per cell, empty voltage per cell. If provided, also enter voltage divider and amps-per-volt

information.

]



QGroundControl can be used to calculate appropriate voltage divider and amps-per-volt

values from measurements:

—_

. Measure the voltage from the battery using a multimeter.

. Click Calculate next to the Voltage divider field. On the prompt that appears:
. Enter the measured voltage.

. Click Calculate to generate a new voltage-divider value.

. Click Close to save the value into the main form.

. Measure the current from the battery.

. Click Calculate next to the Amps per volt field. On the prompt that appears:

. Enter the measured current.

© O N O g A W N

. Click Calculate to generate a new amps per volt value.

. Click Close to save the value into the main form.

—_
o

Advanced Power Settings

Click the Show Advanced Settings checkbox to specify advanced power settings.

Voltage Drop on Full Load

Batteries show less voltage at high throttle. Enter the difference in Volts between idle
throttle and full throttle, divided by the number of battery cells. The default value should

be used if unsure!

WARNING

If the value is too high the battery may be deep-discharged and damaged.

ESC PWM Minimum and Maximum Calibration

To calibrate the ESC max/min PWM values:



1. Remove the propellers.
2. Connect the vehicle to QGC via USB (only).
3. Click the Calibrate button.

WARNING
Never attempt ESC calibration with props on.

Motors should not spin during ESC calibration. However if an ESC doesn't properly support/detect
the calibration sequence then it will respond to the PWM input by running the motor at maximum
speed.

Other Settings

Select the Show UAVCAN Settings checkbox to access additional settings for UAVCAN

Bus Configuration and motor index and direction assignment.

Edit on GitHub

Previous page Next page
PX4 Flight Modes Setup Motors
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Menu On this page

Motor Setup

Motor Setup is used to test individual motors/servos (for example, to verify that motors

spin in the correct direction).

TIP

These instructions apply to PX4 and to most vehicle types on ArduPilot. Vehicle-specific

instructions are provided as sub-topics (e.g. Motors Setup (ArduSub)).

q{g 4 @l ‘ ‘! 4‘_,);:2 E‘IDDB Hold & Hold § ‘ |D|5armed o '

Vehicle Setup Motors Setup

Motors Setup is used to manually test motor control and direction.

Summary

Firmware

Airframe

) O

Moving the sliders will causes the motors to spin. Make
sure you remove all props.

Flight Modes

Fower

Safety




Test Steps
To test the motors:

1. Remove all propellers.

WARNING

You must remove props before activating the motors!

2. (PX4-only) Enable safety switch - if used.

3. Slide the switch to enable motor sliders (labeled: Propellers are removed - Enable motor

sliders).

4. Adjust the individual sliders to spin the motors and confirm they spin in the correct

direction.

INFO

The motors only spin after you release the slider and will automatically stop spinning after 3

seconds.

Additional Information

o Basic Configuration > Motor Setup (PX4 User Guide) - This contains additional PX4-
specific information.

Edit on GitHub

Next page
Motors (ArduSub)

)

Previous page
Power
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Menu Return to top

Safety Setup

The Safety Setup page allows you to configure the most important failsafe settings (other

failsafe settings can be set via the parameters described in the failsafe documentation for

each vehicle type).

For ArduPilot safety page information see: Safety (ArduPilot)

The PX4 page is shown below.
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B %9 < B XY s B100% Hold Disarmed

Vehicle Setup Safety Setup

Summary Safety Setup is used to setup triggers for Return to Land as well as the settings for Return to Land itself.

Hardware in the Loop Simulation

4 HITL Enabled:
r

Low Battery Failsafe Trigger

Firmware
Airframe
Sensors

Bk Failsafe Action: Return to land at critically low level, land at current position if reaching dangerously low levels
io

D Battery Warn Level: 15 %
Rt o Battery Fallsafe Level: 7
S ——

RC Lass Failsafe Trigger

Tuning Failsafe Action:

a

RC Loss Timeout:
Camera

P eretar Data Link Loss Failsafe Trigger

Failsafe Action: Return to Land

7

Data Link Loss Timeout: 10

Geofence Failsafe Trigger

Action on breach:

@ B Max Radius:

B Max Altitude:

Return Home Settings

Climb to altitude of:

Return home, then:
@ Land immediately
@ Loiter and do not land
© Loiter and land after specified time

Loiter Time

Loiter Altitude
Land Mode Settings

ez, Landing Descent Rate:

v Disarm After:

INFO

For additional PX4 safety settings and information see: Safety Configuration.
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Menu On this page

Tuning (PX4)

Tuning only needs to be done once, and is recommended unless you're using vehicle that

has already been tuned by the manufacturer (and not modified since).

Auto-tuning should generally be used for frame types and controllers that support it
(multicopter, fixed wing, and hybrid VTOL fixed wing vehicles). The tuning Ul also supports

manual tuning of all controllers.

Back < ?’Q Vehicle Setup

PID Tuning Setup

Summary

Tuning Setup Is used to tune the flight

Firmware Multirotor

Alrframe Rate Controlier Attitude Controller Velocity Controller Paosition Controller

Airmode (disable during tuning) : | Di
Sensors
TI“'—'"—'L‘:“""E : _

Roll Rate

- Autotune enabled

45.0
Flight Modes 35.0

Autotune: roll

25.0 »\ .ﬂ\ f-—'\
;== . —
\/

-15.0
Motors -25.0 \"//\

-35.0
-45.0

Safety
i -55.0
86.16 86.46 86.76 87.06 B87.36 87.66 B87.96 88.26 B88.56 88.86 B89.16

?$+ sec
PID Tuning
B Response @ Setpoint

Camera

Clear Stop

. Automati

Parameters

INFO

During Airframe Setup you should have selected the frame that most closely matches your
vehicle. This will usually be tuned well enough to fly, and it may also be sufficiently well tuned to

run autotuning.

]



Autotune

Auto-tuning automates the process of tuning the PX4 rate and attitude controllers, which
are the most important controllers for stable and responsive flight (other tuning is more

"optional").

INFO

This guide shows the default usage of this feature. Additional information and configuration can be
found in the PX4 Autotuning Guide (PX4 User Guide).

Pre-Autotuning Test

Auto-tuning is performed while flying. The vehicle must be able to fly and adequately
stabilize itself before running auto-tune. This test ensures that the vehicle can fly safely in
position controlled modes.

To make sure the vehicle is stable enough for auto-tuning:

1. Perform a normal preflight safety checklist to ensure the flight zone is clear and has
enough space.

2. Takeoff and prepare for the test

» Multicopters: Take off and hover at Tm above ground in Altitude mode or Stabilized
mode.

» Fixed-wing mode: Take off and fly at cruise speed in Position mode or Altitude
mode.

3. Use the RC transmitter roll stick to perform the following maneuver, tilting the vehicle
just a few degrees: roll left > roll right > center (The whole maneuver should take about
3 seconds). The vehicle should stabilise itself within 2 oscillations.

4. Repeat the maneuver, tilting with larger amplitudes at each attempt. If the vehicle can
stabilise itself within 2 oscillations at ~20 degrees move to the next step.

5. Repeat the same maneuvers but on the pitch axis. As above, start with small angles and
confirm that the vehicle can itself within 2 oscillations before increasing the tilt.

If the drone can stabilize itself within 2 oscillations it is ready for the auto-tuning

procedure.

If not, see the PX4 User Guide > Autotuning > Troubleshooting.




Auto-tuning procedure

The auto-tuning sequence must be performed in a safe flight zone, with enough space. It
takes about 40 seconds (between 19 and 68 seconds). For best results, we recommend
running the test in calm weather conditions.

INFO

Be ready to abort the autotuning process by moving the RC controller sticks.

The test steps are:

1. Perform the pre-tuning test above.

2. Takeoff using RC control and prepare for test:

o Multicopters: Takeoff using the remote controller in Altitude mode. Hover the vehicle
at a safe distance and at a few meters above ground (between 4 and 20m).

e VTOL in Fixed-wing mode: Once flying at cruise speed, activate Hold Mode. This will
guide the plane to fly in circle at constant altitude and speed.

3. In QGroundControl, open the menu: Vehicle setup > PID Tuning

Back < gﬂ Vehicle Setup

PID Tuning Setup

Summary

Tuning Setup is used to tune the flight controllers.

Firmware Multirotor

Alrframe Rate Controller Attitude Controfler Velacity Controller Position Contralier

isable during tuning) :

Thrust curve :

- Autotune enabled
Radio

Roll Rate

" Autotune: Not performed
Flight Modes et

Power
Mators

Safety
- -10.0
45.57 45.87 46.17 46.47 46.77 47.07 47.37 47.67 47.97 48.27 4B.57

sec
T $+ PID Tuning

H Response @ Setpoint

Camera

Parameters

Switching




4. Select either the Rate Controller or Attitude Controller tabs. Ensure that the Autotune
enabled button is enabled (this will display the Autotune button and remove the manual
tuning selectors).

5. Stop moving the joysticks and click on the Autotune button. Read the warning popup
and click on OK to start tuning.

6. The drone will first start to perform quick roll motions followed by pitch and yaw
motions. The progress is shown in the progress bar, next to the Autotune button.

7. Apply the tuning:

» Fixed Wing: The tuning will be immediately/automatically be applied and tested in
flight (by default). PX4 will then run a 4 second test and revert the new tuning if a
problem is detected.

» Multicopters: Manually land and disarm to apply the new tuning parameters. Takeoff

carefully and manually test that the vehicle is stable.

8. If any strong oscillations occur, land immediately and follow the instructions in PX4 User
Guide > Autotuning > Troubleshooting.

A video of the process is shown below:

QGroundControl Autotune Feature Breakdown for PX4 Autopilot




Manual Tuning

Manual tuning is done in-flight, so your vehicle must already be tuned well enough to fly

with (this is normally the case if you have selected an appropriate default airframe).

The instructions below explain how you can use the manual tuning Ul. It is designed to be

read/used in conjustion with the PX4 Manual PID Tuning Guides, which provide more

detailed hints on the kinds of step sizes to use when changing PID values.
In overview:

1. Takeoff using RC control and prepare for test:

o Multicopters: Takeoff using the remote controller in Altitude mode. Hover the vehicle
at a safe distance and at a few meters above ground (between 4 and 20m).

» Fixed-wing: Once flying at cruise speed, activate Hold Mode. This will guide the
plane to fly in circle at constant altitude and speed.

2. In QGroundControl, open the menu: Vehicle setup > PID Tuning

3. Select the Rate Controller tab. Ensure that the Autotune enabled button is is turned off.



Back < gﬂ Vehicle Setup

PID Tuning Setup

Summary

Tuning p s used to tune the fligh

Firmware Multirotor

Alrframe Rate Controller Attitude Controller Velocity Controller Position Controller

Alrmode (disable during tuning) :
Thrust curve :
B :utotune disabled
Roll Rate select Tuning: QRell  @Pitch @ vaw

Flight Modes
Overall Multiplier (MC_ROLLRATE_K)

Motors

Safety

§hg potuning

Camera

-10.0
216.23 216.38 216.52 216.67 216.81 216.96 217.10 217.24 217.39 21753 217.68
sec

Parameters
B Response @ Setpoint

Clear Stop

..»‘umr'm Flight Mode Switching

Save To Clipboard Restore From Clipboard

4. Select the Tuning axis to tune: Roll, Pitch or Yaw (each axis is tuned separately).

5. Fly the vehicle, observing the tracking on the chart.
» Adjust the Tuning Values (parameters) to improve the tracking shown on the graph
using the slider.

e The values are automatically saved, but you may wish to use the Save to Clipboard
and Restore from Clipboard buttons to store the last known good configuration.

e You can also Clear/Stop the chart using the buttons provided.
6. Tune the other axes.

7. Switch to the other controllers and repeat the process. Screenshots of the tuning pages

are shown below.



'%Q Vehicle Setup

PID Tuning Setu

used to tune the fl

Summary

Firmware Multirotor

Rate Controller Attitude Controller Velocity Controller Position Controller
une d d

Roll Attitude : . QPFRoll @ Pitch

Radio Proportional Gain (MC_ROLL_P)

Flight Mod

Save To Clipboard Restore From Clipboard
Matars

Safety

814 o

Camera

-10.0
22.00 22.80 23.60 2439 2520 26.00 2680 2759 28.40 29.20 30.00
sec

Parameters

H Response @ Setpoint

< %Q Vehicle Setup

Sy PID Tuning Setup

Tun Setup is used to tune the flig

Firmware Multirotor

Alrframe Rate Controller Attitude Controller Velocity Controlier Position Controller

ion contral mode | ple’ during tuni

Horizontal (Y direction, sidewards) Velocity

Flight Modes

increase to reduce steady-state error (e.g. wind)

Differential gain (MPC_XY_VEL_D_ACC)

3.87 4.67 5.47
sec

W Response @ Setpoint

Stop Save To Clipboard Restore From Clipboard




PID Tuning Setup

Summary

Tun etup is used to tun

Alrframe Rate Controller

Sensors

Multirotor

Attitude Controller Velocity Controlier Position Controller

uring tuni

r O Horizontal

Horizontal (Y direction, sidewards) Velocity

Radio

Flight Mc

Proportional gain (MPC_XY_VEL P_ACC)

Incr for respo , reduce if the velo:
{and increasing D does nat help).

Integral gain (MPC_XY _VEL_|_ACC)

Paramety
2.27

Edit on GitHub
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ArduSub Tuning

3.07 3.87 4.67 5.47 6.27
sec

W Response @ Setpoint

Save To Clipboard Restore From Clipboard
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Camera Setup

The details of the page differ if you are using PX4 firmware or ArduPilot firmware.

ArduPilot Camera Setup

B % < % wa B

Gimbal Tilt
Summary

Output channel: Channel 6
Firmware
Input channel: Disabled

Airframe . _ .
Gimbal angle limits: min [BEE

Radio Servo PWM limits: [IlsI 1100

Flight Modes Gimbal Roll

Sensors Output channel: Channel 7

Input channel: Disabled
Power
Gimbal angle limits: min B

Safety

Servo PWM limits: (i 1100

Tuning
Gimbal Pan

Output channel: Channel 8

Parameters Input channel: Disabled

Gimbal angle limits: min [EEE

Servo PWM limits: (il 1100

Gimbal Settings

Type: None

Gimbal Type changes takes affect
next reboot of autopilot

Default Mode: RC Targeting

Unknown

B stabilize

Servo reverse

45 deg

pwm

B stabilize

Servo reverse

45 deg

1900

B stabilize

Servo reverse

45 deg

pwm




Menu On this page

E °\° % A X @ il |,‘] Manual

Summary Vehicle must be restarted for changes to take effect. Anply.and Restare

Camera Trigger Settings

Firmware

Trigger mode: Disable

Airframe . e |
Time Interval

Radio Distance Interval 1

Sensors

Flight Modes

Power

Safety

Tuning

Camera

Parameters

For more information see Camera (PX4 User Guide).

INFO

The camera settings section is not available by default for FMUv2-based flight controllers (e.qg.
3DR Pixhawk) because the camera module is not automatically included in firmware. For more

information see this topic.

Edit on GitHub

Previous page Next page
Tuning (PX4) Joystick
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Menu On this page

Joystick Setup

QGroundControl allows you to control a vehicle using a joystick or gamepad instead of an

RC Transmitter.

INFO

Flying with a Joystick (or virtual thumb-sticks) requires a reliable high bandwidth telemetry

channel to ensure that the vehicle is responsive to joystick movements (because joystick
information is sent over MAVLink).

INFO

Joystick and Gamepad support is enabled using the cross-platform SDL2 library. Compatibility
with a particular controller depends on SDL (all buttons that are exposed by that API are displayed

through the QGroundControl Ul). A number of common joysticks and gamepads are known to

work.

INFO

The joystick is enabled as the last step of the calibration process.

Enabling PX4 Joystick Support

To enable Joystick support in PX4 you need to set the parameter coM RC IN MODE tO 1 -

Joystick. If this parameter is e then Joystick will not be offered as a setup option.

This is enabled by default for PX4 SITL builds (see the Parameters topic for information on

]

how to find and set a particular parameter).



Ardupilot Joystick Support

All ArduPilot vehicles are supported. No parameter configuration is necessary.

Configuring the Joystick

To configure a joystick:

1. Start QGroundControl and connect to a vehicle.

2. Connect the Joystick or Gamepad to a USB port.

3. Select the Gear icon (Vehicle Setup) in the top toolbar and then Joystick in the sidebar.

The screen below will appear.

Vehicle Setup JOYSEiCk’ Setup

Summary General

Enable joystick input
Firmware

Active joystick:

RC Mode:

Roll
Pitch
Flight Modes v

Throttle

Sensors

| Disa rr@ 'j iSiatﬁize :| RDUPIL@T

Button Assigment Calibration Advanced

Sony Interactive Entertainment Wireless Controller =

e O @ e:

4. Make sure your joystick is selected in the Active joystick dropdown.

5. Go to the Calibrate Tab, press the Start button and then follow the on-screen

instructions to calibrate/move the sticks.

]



QGroundControl

% 0\0 @ & ‘ A ":’)‘:g o il 19 lDisarmed " | Stabilize '_| ARDUP'LOT
Vehicle Setup  Joystick Setup

Summary General Button Assigment Calibration Advanced

Firmware

Frame

Flight Modes

Sensors

The joystick is enabled as the last step of the calibration process.

6. Test the buttons and sticks work as intended by pressing them, and viewing the result

in the Axis/Button monitor in the General tab.

7. Select the flight modes/vehicle functions activated by each joystick button.

QGroundControl

‘._D_isarmed 'I ;Sta_bilize '| ARDUP'L@T
Vehicle Setup Joystick Setup

Summary General Calibration Advanced
- IE‘ | No Action m No Action
Firmware |
| No Action E I No Actien
% Joystick | .
|Z| No Action ‘ Mo Action
Frame |E| No Action ‘ No Action
No Action E ‘ No Action
|
I No Action | No Action

Flight Modes | No Action ‘ No Action
| No Action

Sensors




Advanced Options

Some additional Options are available at the Advanced tab. These options may be useful

for specific, unsual setups, for increasing sensibility, and for handling noisy joysticks.

Throttle Options

o Center stick is zero throttle

. Spring loaded throttle smoothing

. Full down stick is zero throttle

G Allow negative Thrust

e Center stick is zero throttle: Centered or lowered stick sends 0 in MANUAL_CONTROL
z, raised stick sends 1000.

e Spring loaded throttle smoothing: In this mode you control not the throttle itself, but
the rate at which it increases/decreases. This is useful for setups where the throttle
stick is spring loaded, as the user can hold the desired throttle while releasing the
stick.

e Full down stick is zero throttle: In this mode, lowered stick sends 0 in
MANUAL_CONTROL z, centered stick 500, and raised 1000.

» Allow negative thrust: When in Center stick is zero throttle mode, this allows the user
to send negative values by lowering the stick. So that lowered stick sends -1000 in
MANUAL_CONTROL z, centered sends zero, and raised stick sends 1000. This mode is
only enabled for vehicles that support negative thrust, such as Rover.

Expo

The expo slider allows you to make the sticks less sensitive in the center, allowing finer

control in this zone.

Exponential:

L~
|: \)::[]._ 9L
\‘\1—"}

The slider adjusts the curvature of the exponential curve.



The higher the Expo value, the flatter the curve is at the center, and steeper it is at the
edges.

Advanced Settings

The advanced settings are not recommended for everyday users. They can cause

unpredicted results if used incorrectly.

Enable further advanced settings (careful!)

Enable gimbal control (Experimental) .

Joystick mode: MNormal ~

Axis frequency (Hz): 2

Enable circle correction

Button repeat frequency (Hz):

Deadbands

Deadband can be set during the first step of calibration by gently wiggling each axis. Deadband
can also be adjusted by clicking and dragging vertically on the corresponding axis monitor.

The following settings are available:
e Enable Gimbal Control: Enabled two additional channels for controlling a gimbal.

» Joystick Mode: Changes what the joystick actually controls, and the MAVLink messages

sent to the vehicle. ﬁ
v



e Normal: User controls as if using a regular RC radio, MAVLink MANUAL_CONTROL
messages are used.

e Attitude: User controls the vehicle attitude, MAVLink SET_ATTITUDE_TARGET
messages are used.

e Position: User controls the vehicle position, MAVLink
SET_POSITION_TARGET_LOCAL_NED messages with bitmask for position only are
used.

o Force: User controls the forces applied to the vehicle, MAVLink
SET_POSITION_TARGET_LOCAL_NED messages with bitmask for force only are used.

e Velocity: User controls the forces applied to the vehicle, MAVLink
SET_POSITION_TARGET_LOCAL_NED messages with bitmask for velocity only are
used.

o Axis Frequency: When the joystick is idle (inputs are not changing), the joystick
commands are sent to the vehicle at SHz. When the joystick is in use (input values are
changing), the joystick commands are sent to the vehicle at the (higher) frequency

configured by this setting. The default is 25Hz.
« Button Frequency: Controls the frequency at which repeated button actions are sent.

o Enable Circle Correction: RC controllers sticks describe a square, while joysticks usually
describe a circle. When this option is enabled a square is inscribed inside the joystick
movement area to make it more like an RC controller (so it is possible to reach all four

corners). The cost is decreased resolution, as the effective stick travel is reduced.

» Disabled: When this is disabled the joystick position is sent to the vehicle unchanged
(the way that it is read from the joystick device). On some joysticks, the (roll, pitch)
values are confined to the space of a circle inscribed inside of a square. In this figure,
point B would command full pitch forward and full roll right, but the joystick is not
able to reach point B because the retainer is circular. This means that you will not be

able to achieve full roll and pitch deflection simultaneously.



D C

o Enabled: The joystick values are adjusted in software to ensure full range of
commands. The usable area of travel and resolution is decreased, however, because

the area highlighted grey in the figure is no longer used.

» Deadbands: Deadbands allow input changes to be ignored when the sticks are near
their neutral positions. This helps to avoid noise or small oscillations on sensitive sticks
which may be interpreted as commands, or small offsets when sticks do not re-center
well. They can be adjusted during the first step of the calibration, or by dragging

vertically on the corresponding axis monitor.

]



Supported Joysticks

The following joysticks/controllers have been shown to work with relatively recent
QGroundControl builds.

Sony Playstation 3/4 Controllers

Both these joysticks are highly recommended. They work well "out of the box" and have

many buttons that you can map to flight modes.
Sony PS4 - DualShock 4 Controller V2 (Wireless setup)

This controller supports both USB and Bluetooth wireless connection. Wired USB

connection usually works out of the box. The wireless connection needs some setup.
Linux Ubuntu setup

To make the controller work wirelessly under Linux the jstest-gtk and ds4drv utilities are

needed.

The steps are:

1. Install jstest-gtk:

sudo apt install jstest-gtk
2. Install ds4drv:

sudo pip install ds4drv

3. Run ds4drv

sudo ds4drv

4. Hold Share button and then PS button until controller LED starts blinking rapidly. The

ds4drv should then detect a new device.
pDISA



5. Last of all, you should check the controller setup by running the jstest-gtk utility.

FrSky Taranis XD9 plus

The FrSky Taranis XD9 plus remote control can also be connected as a joystick. You will

need to connect it via the USB port on the back.
The Taranis does not allow you to use button options (to be precise, you can set the

options, but toggling the buttons on your transmitter does not cause them to be pressed).

INFO

The Taranis is an open system that is openly being worked on. It is possible that at time of writing
there is a firmware or configuration that allows it to work effectively as a joystick.

Logitech Gamepad F310

The Logitech Gamepad F310 has been tested via USB on MacOSX "Sierra".

Logitech Extreme 3D Pro

The Logitech Extreme 3D Pro Joystick has been tested on all platforms (Linux, Windows,

Mac OSX). This is a single stick controller that can also be twisted. The main stick axes are
used for pitch and roll, while the twist action is used for yaw. The throttle is mapped onto a

separate wheel.

Logitech F710 Gamepad

This gamepad is great for flying a multirotor manually via QGroundControl. It works on
Windows, Linux and Mac OS.

Mac OS Leopard / Lion Setup

The F710 is detected under Leopard / Lion but is not automatically configured as an input
device. In order to get a working configuration, the F710 has to be recognised as
Rumblepad?2.

]



First check how it is recognised: Apple > About this Mac > Additional Information >
System Report > USB. It is detected as "Logitech Cordless RumblePad 2" then nothing

further needs to be done.
If it is detected as a "Logitech Wireless 710", perform these steps:

1. Unplug the USB receiver of the gamepad

2. Prepare to quickly plug it into a USB port

3. Hit the Logitech button (its silver with the Logitech Logo on it in the center of the pad)
4. Quickly connect the USB receiver to your Mac

5. The pad should now be detected in the system report as "Logitech Cordless RumblePad
2".If not, retry the above steps.

Edit on GitHub

Previous page Next page
Camera Parameters



QGC Guide (master)

Menu On this page

Parameters

The Parameters screen allows you to find and modify any of the parameters associated

with the vehicle.

B8 'ﬂu'ﬂ, °K° &‘ a5 _gﬂl_oﬂ g « [E100% Hold Disarmed

Summary Component #:-1 BAT_A_PER_V 39103031 Battery current per volt (A/V)
*Default Group
BAT_CAPACITY - & Battery capacity
Firmware

Battery Cailbration BAT_CNT_V_CURR 0. BOOB05EE Scaling from ADC counts to volt on the ADC input (battery current)

Alrframe Camera trigger BAT_CNT_V_VOLT [.000B056¢ Scaling from ADC counts to volt on the ADC input (battery voltage)

Circuit Breaker BAT_CRIT_THR Critical threshald
Radio

Commander BAT_EMERGEN_THR Emergency threshold

Sensors A 0
Data Link Lass BAT_LOW_THR Low threshold
BAT_N_CELLS Jatts Number of calls
Flight Modes EKF2
BAT_R_INTERNAL -1.000 Ohms Explicitly defines the per cell internal resistance
FW Attitude Control
Power BAT_SOURCE Power Module Battery monitoring source
FW L1 Control h )
BAT_V_CHARGED 405V Full cell voltage (5C load)
Safety

RSt detecion BAT_V_DIV { G i Battery voltage divider (V divider)

Tuning FW TECS BAT_V_EMPTY 3.40V Empty cell voltage (5C load)

_ Follow target BAT_V_LOAD_DROP 0.30V Voltage drop per cell on full throttle
Camera

GPS Fallure Navigation BAT_V_OFFS_CURR 0.00000000 Offset in volt as seen by the ADC input of the current sensor

% Parameters
Geofence

Land Detector
INFO

PX4 Pro and ArduPilot use different parameter sets, but they are both managed as described in
this section.

Finding a Parameter



The parameters are organized in groups. Select a group of parameters to view by clicking

on the buttons to the left (in the image above the Battery Calibration group is selected).

You can also search for a parameter by entering a term in the Search field. This will show
you a list of all parameter names and descriptions that contain the entered substring

(press Clear to reset the search).

g ° )
[E] %ﬂ 9 [}1 ‘ oy djﬂl_% o « [ 100% Hold Disarmed
Vehicle Setup Canrct: Clear

Summary FW_LND FLALT BOm Landing flare altitude (relative to landing altitude)

FW LND FL PMAX 15.0 deg Flare, maximum pitch
Frmware

FW_LND_FL_PMIN 2.5 deg Flare, minimum pitch
Airframe LND_FLIGHT _T_HI ] Tatal flight time in microsecands

LND _FLIGHT T _LO } Total flight time in microseconds
Radio

Changing a Parameter

To change the value of a parameter click on the parameter row in a group or search list.
This will open a side dialog in which you can update the value (this dialog also provides
additional detailed information about the parameter - including whether a reboot is

required for the change to take effect).

% %9 2| € X2 o a B100% Hoid Disarmed

Vehicle Setup Search: | | Parameter Editor

Summary COM_ARM_MIS REQ Disabled Require valid mission to arm

. MIS_ALTMODE First Order Hold Altitude setpoint mode
Firmware 10.0

MIS_DIST_iwP 900.0 m Maximal horizontal distance from home to first waypoint

. e | ini f'h P ari
Airframe MIS_LTRMIN_ALT ' Minimum Lofter altitude ;_TIS is the minimum altitude the system will take off

. MIS_ONBOARD_EN Enabled Persistant onboard mission storage Min: 0.0 Max: 80.0 Default: 2.5

MIS_TAKEOFF_ALT ! Take-off altitude Parameter name: MIS_TAKEOFF_ALT

Sensors VATM 1 A : Mo Ve i
MIS YAWMODE Heading towards waypoint Multirotor only. Yaw setpoint mode Warning: Modifying values while vehicie is in flight
VAL PrrTg P : 5 i = A St can lead to vehicle instability and possible vehicle
Fiight Modes MIS_YAW_ERR 12.0 deg Max yaw error in degrees needed for waypoint heading accepter | i e you know what you are doing and
che A cavel
MIS_YAW_TMT ( Time in seconds we wait on reaching target heading at a waypgi e e oGk B e Savel

Power —— B Advanced settings

Safety




INFO

When you click Save the parameter is automatically and silently uploaded to the connected
vehicle. Depending on the parameter, you may then need to reboot the flight controller for the
change to take effect.

Tools

You can select additional options from the Tools menu on the top right hand side of the

screen.

Battery current per volt (A/V) Refresh

Battsry capacity Reset all to defaults

Scaling from ADC counts to volt on the ADC input Load from file...

Save to file...
Scaling from ADC counts to volt on the ADC input

Clear RC to Param
Critical threshold

Reboot Vehicle
Emergency threshold

Refresh

Refresh the parameter values by re-requesting all of them from the vehicle.

Reset all to defaults

Reset all parameters to their original default values.

Load from file / Save to file

Load parameters from an existing file or save your current parameter settings to a file.

Clear RC to Param
This clears all associations between RC transmitter controls and parameters. For more

information see: Radio Setup > Param Tuning Channels.

]



Reboot Vehicle

Reboot the vehicle (required after changing some parameters).

Edit on GitHub
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Menu On this page

Settings View

The Settings View is used to configure the settings for the QGroundControl application
(rather than a specific vehicle). You do not have to have a vehicle connected to change

these values.

You can switch between the various settings options by clicking the buttons in the left-

sidebar.

|§] %ﬂ OKQ @1‘ o _;,.ﬂi_% m B 100% Hold Disarmed

Application Settings

General

Comm Links

Units (Requires Restart)

Meters

SquareMeters
Offline Maps

Meters/second
MAVLink

Eormols Miscellaneous

Color Scheme: Indoor v

Settings Options

General
The main application configuration settings. These are used to specify: display units,

autoconnection devices, video display and storage, RTK GPS, etc.

Comm Links
Allows you to manually create communication links and connect to them. Keep in mind that

normally this is not needed since QGroundControl will automatically connect to the most

]

common devices.



Offline Maps

Allows you to cache maps for use while you have no Internet connection.

MAVLink

Settings associated with the MAVLink connection to a vehicle.

Console

Used to capture application logs for help with diagnosing application problems.

Edit on GitHub

Previous page Next page
Parameters General
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Menu On this page

General Settings (Settings View)

The general settings (SettingsView > General Settings) are the main place for application-
level configuration. Settable values include: display units, autoconnection devices, video

display and storage, RTK GPS, brand image, and other miscellaneous settings.

INFO

Values are settable even if no vehicle is connected. Settings that require a vehicle restart are
indicated in the Ul.



Distance Meters

Area | SguareMeters

Speed ‘ Meters/second

Temperature I Celsius

Miscellaneous

Language System

Color Scheme Indoor

Map Provider Bing

Map Type Hybrid

Stream GCS Position | When in Follow Me Flight Mode

UI Scaling - 103% @+

. Mute all audio output

Check for Internet connection
. Autoload Missions

.{Zlear all settings on next sart

Announce battery lower than
Eetuel iz ey M o = =R e 1l Willee/Documents/QGroundControl

Data Paersistence

. Disable all data persistence

When Data Pardetence is disshled, all telametry logaing
and map e caching s disabled and not written o disk.

Telemetry Logs from Vehicle

Sa'.re log after each flight
. Save logs even if vehicle was not armed
[l save CSV log of telemetry data

Fly View
[ Use Preflight Checklist

[ ]




. Keep Map Centered On Vehide

. Show Telemetry Log Replay Status Bar

B virtual Joystick

. Use Vertical Instrument Panel

.5hﬂw additional heading indicators on Compass
. Lock Compass Nose-Up

Guided Minimum Alttude

Guided Maximum Altitude 122 m

Go To Location Max Distance m

Plan View

Default Mission Alttude m

AutoConnect to the following devices

P pixhawk [ sik Radic ¥ P4 Flow ¥ uibrepilot [ upr P RrTK GPS

NMEA GPS Device [ Disabled - |

RTK GPS

Q Perform Survey-In

Survey in accuracy (U-blox only)
Minimum observation time

@ Use Specified Base Position
Base Position Latitude
Base Position Longitude
Base Position Alt (WGS84)
Base Position Accuracy

Save Current Base Poaition

ADSB Server

B connect to ADSB SBS server

Host address 127.0.0.1

Server port 30003




Video Source | Video Stream Disabled

Brand Image

Reset Default Brand Image

Outdoor Image Browse

Units

This section defines the display units used in the application.
Units (Requires Restart)
Distance Meters
Area SquareMeters

Speed Meters/second

Temperature  Celsius

The settings are:

Distance: Meters | Feet

Area: SquareMetres | SquareFeet | SquareKilometers | Hectares | Acres | SquareMiles

Speed: Metres/second | Feet/second | Miles/hour | Kilometres/hour | Knots

Temperature: Celsius | Fahrenheit

Miscellaneous

This section defines a number of miscellaneous settings, related to (non exhaustively): font
sizes, colour schemes, map providers, map types, telemetry logging, audio output, low

battery announcement levels, default mission altitude, virtual joysticks, mission

autoloading, default application file load/save path etc.

]



Miscellaneous

Language | System

Color Scheme | Indoor

Map Provider | Bing

Map Type Hybrid

Stream GCS Position | When in Follow Me Flight Mode

UI Scaling - 103% +

. Mute all audio output

Check. for Internet connection
. Autoload Missions

.Clear all settings on next start

_.ﬁ._nnﬂunce battery lower than m
Application Load/5Save Path R0 el agl=ly oyl @ eTgall gl @alylags] Browse

The settings are:

« Language: System (System Language) | Bulgarian, Chinese, ...



Brnrapckw (Bulgarian)
&5 X [Chinese)
Nederlands (Dutch)
English
Suomi (Finnish)
Francais (French)
Deutsche (Garman)
EAluikd (Greek)
(Hebrew) 0w
Ialianc (Tialian)

B#*& A (Japanese)

=3 0] (Korean)

Norsk (Norwegian)
Palskie (Polish)
Partugués (Portuguese)
Pycouwmid (Russian)
Espafiol (Spanish)
Svenska (Swedish)

Tiirk (Turkish)

Translations are generally built into the application and selected automatically based on
the system language.

Metadata downloaded from the vehicle (such as parameter descriptions) might have
translations as well. These are downloaded from the internet upon vehicle connection.
The translations are then cached locally. This means an internet connection during

vehicle connection is required at least once.

Color Scheme: Indoor (Dark) | Outdoor (Light)

Map Provider: Google | Mapbox | Bing | Airmap | VWorld | Eniro | Statkart
Map Type: Road | Hybrid | Satellite

Stream GCS Position: Never | Always | When in Follow Me Flight Mode. [—MS,_\\ N



» Ul Scaling: Ul scale percentage (affects fonts, icons, button sizes, layout etc.)
« Mute all audio output: Turns off all audio output.

e Check for Internet Connection: Uncheck to allow maps to be used in China/places
where map tile downloads are likely to fail (stops the map-tile engine continually

rechecking for an Internet connection).

» Autoload Missions: If enabled, automatically upload a plan to the vehicle on connection.

e The plan file must be named AutoLoad#.plan, where the # is replaced with the
vehicle id.

e The plan file must be located in the Application Load/Save Path.

o Clear all settings on next start: Resets all settings to the default (including this one)

when QGroundControl restarts.

e Announce battery lower than: Battery level at which QGroundControl will start low

battery announcements.

» Application Load/Save Path: Default location for loading/saving application files,

including: parameters, telemetry logs, and mission plans.

Data Persistence

Data Persistence

. Disable all data persistence

When Data Persistence s disabled, all telemetry logging
andd map e caching k disabled and not written o disk,

The settings are:

» Disable all data persistence: Check to prevent any data being saved or cached: logs,
map tiles etc. This setting disables the telemetry logs section.

Telemetry Logs from Vehicle [osa_



Telemetry Logs from Vehicle

Save log after each flight

. Save logs even if vehicle was not armed
. Save CSV log of telemetry data

The settings are:

» Save log after each flight: Telemetry logs ( .tlog ) automatically saved to the
Application Load/Save Path (above) after flight.

» Save logs even if vehicle was not armed: Logs when a vehicle connects to
QGroundControl. Stops logging when the last vehicle disconnects.

e CSV Logging: Log subset of telemetry data to a CSV file.

Fly View

Fly View

B Use preflight Checklist

. Keep Map Centered On Vehicle
.5hc-w Telemetry Log Replay Status Bar
. Virtual Joystick

. Use Vertical Instrument Panel

ISth additional heading indicators on Compass
Bl Lock Compass Nose-Up

Guided Minimum Altitude

Guided Maximum Altitude 122 m

Go To Location Max Distance

The settings are:
« Use Preflight Checklist: Enable pre-flight checklist in Fly toolbar.
« Enforce Preflight Checklist: Checklist completion is a pre-condition for arming.

» Keep Map Centered on Vehicle: Forces map to center on the currently selectedr@nidﬁ
M v



» Show Telemetry Log Replay Status Bar: Display status bar for Replaying Flight Data.

« Virtual Joystick: Enable virtual joysticks (PX4 only)

» Use Vertical Instrument Panel: Align instrument panel vertically rather than horizontally
(default).

» Show additional heading indicators on Compass: Adds additional indicators to the

compass rose:
e Blue arrow: course over ground.

o White house: direction back to home.
e Green line: Direction to next waypoint.

» Lock Compass Nose-Up: Check to rotate the compass rose (default is to rotate the

vehicle inside the compass indicateor).
e Guided Minimum Altitude: Minimum value for guided actions altitude slider.
e Guided Maximum Altitude: Minimum value for guided actions altitude slider.

e Go To Location Max Distance: The maximum distance that a Go To location can be set

from the current vehicle location (in guided mode).

Plan View

Plan View

Default Mission Altitude m

The settings are:

o Default Mission Altitude: The default altitude used for the Mission Start Panel, and
hence for the first waypoint.

]



AutoConnect to the following devices
This section defines the set of devices to which QGroundControl will auto-connect.

AutoConnect to the following devices

P rixhawk [ sik radio [ Px4 Flow [ubrepiior [PJuor P rTK GPs

NMEA GPS Device | Disabled - ‘

Settings include:

e Pixhawk: Autoconnect to Pixhawk-series device
o SiK Radio: Autoconnect to SiK (Telemetry) radio
e PX4 Flow: Autoconnect to PX4Flow device

o LibrePilot: Autoconnect to Libre Pilot autopilot

o UDP: Autoconnect to UDP

e RTK GPS: Autoconnect to RTK GPS device

« NMEA GPS Device: Autoconnect to an external GPS device to get ground station
position (see below)

Ground Station Location (NMEA GPS Device)

QGroundControl will automatically use an internal GPS to display its own location on the
map with a purple q icon (if the GPS provides a heading, this will be also indicated by the
icon). It may also use the GPS as a location source for Follow Me Mode - currently

supported on PX4 Multicopters only.

You can also configure QGC to connect to an external GPS device via a serial or UDP port.

The GPS device must support the ASCII NMEA format - this is normally the case.
TIP

A higher quality external GPS system may be useful even if the ground station has internal GPS
support.

]



Use the NMEA GPS Device drop-down selector to manually select the GPS device and

other options:

e USB connection:

MMEA GPS Device Serial <none available> -

NMEA GPS Baudrate e -

e NMEA GPS Device: Serial

« NMEA GPS Baudrate: The baudrate for the serial port

TIP

To troubleshoot serial GPS problems: Disable RTK GPS auto connection, close QGroundControl,

reconnect your GPS, and open QGC.

e Network connection:

NMEA GPS Device UDP Port -

NMEA stream UDP port [REE

e NMEA GPS Device: UDP Port.

« NMEA Stream UDP Port: The UDP port on which QGC will listen for NMEA data (QGC
binds the port as a server)

RTK GPS

This section allows you to specify the RTK GPS "Survey-in" settings, to save and reuse the
result of a Survey-In operation, or to directly enter any other known position for the base

station.



RTK GPS

© Perform Survey-In

Survey in accuracy (U-blox only) &y m

Minimum observation time 180 5805

@ Use Specified Base Position

INFO

The Survey-In process is a startup procedure required by RTK GPS systems to get an accurate
estimate of the base station position. The process takes measurements over time, leading to
increasing position accuracy. Both of the setting conditions must met for the Survey-in process to
complete. For more information see RTK GPS (PX4 docs) and GPS- How it works (ArduPilot docs).

TIP

In order to save and reuse a base position (because Survey-In is time consuming!) perform
Survey-In once, select Use Specified Base Position and press Save Current Base Position to copy
in the values for the last survey. The values will then persist across QGC reboots until they are
changed.

The settings are:

e Perform Survey-In

e Survey-in accuracy (U-blox only): The minimum position accuracy for the RTK
Survey-In process to complete.

¢ Minimum observation duration: The minimum time that will be taken for the RTK
Survey-in process.

» Use Specified Base Position
o Base Position Latitude: Latitude of fixed RTK base station.

» Base Position Longitude: Longitude of fixed RTK base station. ’ DISA_



» Base Position Alt (WGS94): Altitude of fixed RTK base station.
o Base Position Accuracy: Accuracy of base station position information.

o Save Current Base Position (button): Press to copy settings from the last Survey-In
operation to the Use Specified Base Position fields above.

ADSB Server

ADSB Server

B Connect to ADSB SBS server

plima=lanig=-0 127.0.0.1

Server port 30003

The settings are:

e Connect to ADSB SBS server: Check to connect to ADSB server on startup.
e Host address: Host address of ADSB server

e Server port: Port of ADSB server

QGC can consume ADSB messages in SBS format from a remote or local server (at the

specified IP address/port) and display detected vehicles on the Fly View map.

TIP

One way to get ADSB information from nearby vehicles is to use dump1090 to serve the data from
a connected RTL-SDR dongle to QGC.

The steps are:
1. Get an RTL-SDR dongle (and antenna) and attach it to your ground station computer (you may
need to find compatible drivers for your OS).
2. Install dump1090 on your OS (either pre-built or build from source).

3. Run dumpie9e --net to start broadcasting messages for detected vehicles on TCP localhost
port 30003 (127.0.0.1:30003).

4. Enter the server ( 127.0.0.1 ) and port ( 3ee03 ) address in the QGC settings above.

5. Restart QGC to start seeing local vehicles on the map.

]



Video

The Video section is used to define the source and connection settings for video that will
be displayed in Fly View.

Yideo Source UDP h.264 Video Stream
UDP Part Video Stream Disabled
AL eyl RTSP Video Stream
Aspect Ratlo

Disable When Disarmed UDF h.264 Video Stream
LIDP h.265 Video Stream
Videa Recording
TCP-MPEGZ Video Stream
Auto-Delete Flles

MPEG-TS (h.2684) Video Strea

T
Video Fle Format | mikx

The settings are:

« Video Source: Video Stream Disabled | RTSP Video Stream | UDP h.264 Video Stream |
UDP h.265 Video Stream | TCP-MPEG2 Video Stream | MPEG-TS (h.264) Video Stream |
Integrated Camera

INFO

If no video source is specified then no other video or video recording settings will be displayed
(above we see the settings when UDP source is selected).

o URL/Port: Connection type-specific stream address (may be port or URL).
« Aspect Ratio: Aspect ratio for scaling video in video widget (set to 0.0 to ignore scaling)
» Disabled When Disarmed: Disable video feed when vehicle is disarmed.

 Low Latency Mode: Enabling low latency mode reduces the video stream latency, but

may cause frame loss and choppy video (especially with a poor network connection).

]



Video Recording

The Video Recording section is used to specify the file format and maximum allocated file
storage for storing video. Videos are saved to a sub-directory ("Video") of the Application
Load/Save Path.

Video Recording
Auto-Delete Files [}

Video File Format | mkv

Video Recording

Auto-Delete Files

Max Storage Usage RETEETY MB

Video File Farmat | miky - |

The settings are:

« Auto-Delete Files: If checked, files are auto deleted when the specified amount of
storage is used.

« Max Storage Usage: Maximum video file storage before video files are auto deleted.

» Video File Format: File format for the saved video recording: mkv, mov, mp4.

Brand Image
This setting specifies the brand image used for indoor/outdoor colour schemes.

The brand image is displayed in place of the icon for the connected autopilot in the top
right corner of the toolbar. It is provided so that users can easily create screen/video

captures that include a company logo/branding.



Brand Image

Indoor Image Browse

Outdoor Image

Reset Default Brand Image

The settings are:

» Indoor Image: Brand image used in indoor color scheme

e Outdoor Image: Brand image used in outdoor color scheme

» Reset Default Brand Image: Reset the brand image back to default.

Edit on GitHub
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CSV Logging

Telemetry Logs from Vehicle

Save log after each flight

.Save logs even if vehicle was not armed

ISENE CSV log of telemetry data

When checked, a CSV (comma-separated value) telemetry file will be created along with
the usual .tlog telemetry file. The file is only created if Save log after each flight is

enabled, and is recorded for the same duration.

This CSV file contains the most relevant vehicle telemetry data available for quick analysis
such as GPS position, attitude, battery status, and others. It is populated at 1 Hz and while
it is not as detailed as the telemetry log, it is a lot easier to work with and quicker to

extract data out of.

The file can be opened by common spreadsheet software, including: Microsoft Excel,

Google Sheets, LibreOffice Calc or OpenOffice Calc.

Edit on GitHub

Previous page Next page
General Offline Maps
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Offline Maps

% 9 4 &R 0 W B ARDUPILOT

Application
Settings Add new set »

General Default Tile Set 25.4MB (2212 tiles) ® W

Comm Links

Offline Maps

MAVLink

Flying Field 617.9kB (67 tiles) @ W

Console

Options

Offline Maps allows you to cache map tiles for use when not connected to the Internet.

You can create multiple offline sets, each for a different location.

Add new set

To create a new offline map set, click "Add new set". Which will take you to this page:

]



% Y9 4 & . ARDUPILOT

Application
Settings @

General

Comm Links

Offline Maps

MAVLink e O e |V Add New Set

NE (K

Console : ‘ ! § Flying Field|
o % . 1 Map type:
Bing Hybrid Map

Min Zoom: 12

Max Zoom: 19

Max Zoom: 19 : . Count: 67
1 v Est Size: 1.3MB

Download Cancel

From here you can name your set as well as specify the zoom levels you want to cache.

Move the map to the position you want to cache and then set the zoom levels and click
Download to cache the tiles.

To the left you can see previews of the min and max zoom levels you have chosen.

Edit on GitHub
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MAVLink Settings

The MAVLIink settings (SettingsView > MAVLink) allow you to configure options and view
information specific to MAVLink communications. This includes setting the MAVLink

system ID for QGroundControl and viewing link quality.

The screen also allows you to manage MAVLink 2 Log Streaming (PX4 only), including

automating log upload to Flight Review!
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Ground Station

This section sets the MAVLink properties and behaviour of QGroundControl.

Ground Station

MAVLInk System ID: 255

Emit heartbeat

Only accept MAVs with same protocol version
. Enable MAVLink forwarding

Host name:

Changing the host name requires restart of application,

e MAVLink System ID: System ID of QGroundControl on the MAVLink network (Default:
255). Vehicles are typically allocated IDs from 1. You may have to specify another ID if
there are multiple ground stations or MAVLink applications on the network.

o Emit heartbeat: Disable emission of regular MAVLink HEARTBEAT message (Default:
True). Generally speaking, you should not turn this off.

e Only accept MAVs with the same protocol version: Set true to only connect to MAVLink
1 or to MAVLink 2 vehicles (Default: True).

» Enable MAVLink forwarding: Enable QGroundControl to forward MAVLink messages
from connected vehicles to another UDP endpoint (Default: False). Note that this
forwarding is one-way: from QGC to the specified host. Any MAVLink messages that are
received from the specified host will be ignored.

Link Status

This shows the status of MAVLink message transfer over the communications link. A high
Loss rate may lead to protocol errors for things like parameter download or mission

upload/download.



MAVLink Link Status (Current Vehide)

Total messages sent (computed):

Totzl messages received:
Total message loss:
Loss rate:

MAVLink 2 Logging (PX4 only)

The MAVLink 2 Logging settings (PX4 only) configure real-time log streaming from PX4 to
QGroundControl and upload of logs to Flight Review.

WARNING

MAVLink 2 Logging cannot be used on "basic" setups because it requires a constant high-rate

MAVLink connection to the vehicle (it may work over WiFI but will not work over a Telemetry link).

TIP

In theory log streaming allows real time analysis of data. At time of writing real-time analysis has
not yet been implemented.

The log format is the same as for SD Card logs (downloaded using Analyze View > Log

Download), but actual data logged may be slightly different because log start/stop time is
controlled by QGroundControl and because some dropouts may occur when streaming

over a lossy channel.

The MAVLink 2 Logging section allows you to manually start and stop logging, and to
enable automatic capture of logs.

MAYLink 2.0 Logging (PX4 Firmware Only)

Manual Start/Stop:

B Enable automatic logging

The MAVLink 2 Log Uploads section allows you configure uploading of MAVLink logs to
Flight Review. You can specify all the fields that you would otherwise have to direti DISA_ v




in the site, and also choose whether logs are automatically or manually uploaded.
MAVYLink 2.0 Log Uploads (PX4 Firmware Only)

Email address for Log Upload:
Default Description: QGroundControl Session

Default Upload URL https://logs. pxd.io/upload

Video URL:

Wind Speed: Please Select

Flight Rating: Please Select
Additional Feedback:

O Make this log publicly available
O Enable automatic log uploads
B Delete log file after uploading

The fields are:

« Email address for Log Uploads: Flight Review will email you a link to the upload at this
address. This is important as otherwise you will have no way to access a non-public log
after upload.

» Default Description: Description/name of flight used for log.

« Default Upload URL: URL for upload of the log/log metadata. This is set by default to
the Flight Review URL.

« Video URL: (Optional) URL for video of flight associated with log. This may be included
on the Flight Review page to ease analysis.

» Wind Speed: Used to aid debugging and filtering (from multiple flights). Allowed values:
Calm | Breeze | Gale | Storm.

» Flight Rating: Used to aid debugging and filtering (from multiple flights). Allowed values:
Crashed (Pilot Error) | Crashed (Software or Hardware Issue) | Unsatisfactory | Good |
Great.

« Additional Feedback: (Optional). Enter a more detailed description of the flight or
behaviour.

« Make this log publically available: If set, the log will be visible and searchable on Flight
Review. If not set, it will only be available via the link emailed on upload.
DISA v



e Enable automatic log uploads: If set, the log will automatically be uploaded on

completion.
» Delete log file after uploading: If set, the log will automatically deleted after upload.

The Saved Log Files section is used to manually manage log uploads. Use the checkboxes

and buttons to select logs, and either delete or upload them.

TIP
You can change the parameters in MAVLink 2 Log Uploads above to specify separate descriptions

for uploaded logs.

Saved Log Files

12,175,573
662,365,358

Edit on GitHub
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Console Logging

The Console can be helpful tool for diagnosing QGroundControl problems. It can be found

in SettingsView > Console.

File Widgets

@) % %@ 2

Application Settings T . ) N _ . ) .
[D] at ..\src\QGCApplication.cc: 259 - "Settings location "C:/Users/hamis/AppData/Roaming/QGroundCantrol. org/QGroundControl.ini” Is writable?:

General true
[D] at ..\src\QGCLoggingCategory.cc:99 - "Filter rules "gt. networlk.ssl.warning=false\n*Log.debug=false\nloystickValuesLog.debug=true
Comm Links \rdoystickManagerLog.debug=true\nAPMAirframeloaderl og.debug=true\n""

[E] at :0 - "serialnmea: Mo serial ports found"
Offline Maps [D] at ..\src\Vehicle\MAVLinkl ogManager.cc: 359 - "MAVLink logs directory: "C:/Users/hamis/Documents/QGroundControl/Logs™

Rk [D] at ..\src\QtLocationPlugin\QGCMapEngine.cpp: 215 - "Map Cache in: "C:/Users/hamis/AppData/Local/cache/QGCMapCacha300” /
N " n
‘ggcMapCache.db

[D] at gre://fgmifQGroundControl/ScreenTools/ScreenTools.gml: 117 - "0.05185185185185185"
nsole

[D] at gre://fgml/QGroundControl/FlightDisplay/ GuidedActionsController.qml:125 - "_activeVehicle(0) _vehicleArmed(0) guidedModeSupported(0)
_vehidleFlying(0) _vehicleInRTLMode(0) pauseVehicleSupported(0) _vehiclePaused(0) _flightMode()"

[D] at gre:///gml/QGroundControl/FlightDisplay/ GuidedActionsController.gml: 125 - "_activeVehicle(0) _vehicleArmed(0) guidedModeSupported(0)
_vehidleFlying(0) _vehidelnRTLMode(0) pauseVehicleSupported(0) _vehiclePaused(0) _flightMode()"

[D] at gre://fgml/QGroundControl/Controls/SliderSwitch.gml: 74 - "32 56"

[D] at gre:/f/gml/QGroundControl/FlightDisplay/GuidedActionsController.gml: 125 - *_activeVehicle(0) _vehicleArmed(0) guidedModeSupported(0)
_vehicleFlying(0) _vehidelnRTLMode(0) pauseVehicleSupported(0) _vehiclePaused(0) _flightMode()"

[D] at ..\src\comm\MAVLinkProtocol.cc:413 - "Orphaned log file count 0°

Show Latest JECEEREe

Click the Set Logging button to enable/disable logging information displayed by
QGroundControl.

Common Logging Options

The most commmonly used logging options are listed below.



Option(s) Description
LinkManagerLog , MultiVehicleManagerlog Debug connection problems.

Debug serial ports not being detected.

LinkManagerVerboselog Very noisy continuous output of available
serial ports.

FirmwareUpgradelog Debug firmware flash issues.

ParameterManagerlog Debug parameter load problems.

ParameterManagerDebugCacheFailurelog Debug parameter cache crc misses.

PlanManagerLog , MissionManagerlLog , .
Debug Plan upload/download issues.
GeoFenceManagerLog , RallyPointManagerlLog

RadioComponentControllerLog Debug Radio calibration issues.

Logging from the Command Line

An alternate mechanism for logging is using the --logging command line option. This is

handy if you are trying to get logs from a situation where QGroundControl crashes.
How you do this and where the traces are output vary by OS:
o Windows

* You must open a command prompt, change directory to the qgroundcontrol.exe
location, and run it from there:
sh

cd "\Program Files (x86)\ggroundcontrol”
ggroundcontrol --logging:full

 When QGroundControl starts you should see a separate console window open which

will have the log output

e« OSX (}igii:—:“



e You must run QGroundControl from Terminal. The Terminal app is located in

Applications/Utilities. Once Terminal is open paste the following into it:

sh
cd /Applications/qgroundcontrol.app/Contents/Mac0S/
./qgroundcontrol --logging:full
e Log traces will output to the Terminal window.
Linux
sh
./qgroundcontrol-start.sh --logging:full
e Log traces will output to the shell you are running from.
Edit on GitHub
Previous page Next page
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Virtual Joystick

QGroundControl allows you to control a vehicle with on-screen virtual thumbsticks. These

are displayed as shown below in the flight view.

File Widgets

%{} 0{9 4:] @1‘ Fiy x Stabilized

Mo,

INFO

Thumbstick control is not as responsive as using an RC Transmitter (because the information is
sent over MAVLink). Another alternative is to use a USB Joystick/Gamepad.

]



Enable the thumbsticks

To enable the virtual joysticks:

1. Select the Q icon from the top toolbar
2. Open the Application Settings

3. Make sure you're on the General tab

4. Check the Virtual joystick box

Application Settings

FI:‘. s

Comm Links

[l Use Prenight Checkiist

Offline Maps
MAVLink

Console

Help W camera controls (DIGICAM_CONTROL)

i Command Settings

Minimum Altitude

Maximum Altitude

Go To Location Max Distance m
Vi

" -

Default Mission Altitude
VTOL TransitionDistance

Edit on GitHub
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Analyze View

The Analyze View is accessed by selecting the QGroundControl application menu ("Q" icon
in the top left corner) and then selecting the Analyze Tools button (from the Select Tool
popup).

-
Select Tool

The view provides tools to:

 Download Logs — List, download and clear logs on the vehicle.

o GeoTag Images (PX4) — Geotag survey mission images using the flight log (on a
computer).

e MAVLink Console (PX4) — Access the the nsh shell running on the vehicle.

e MAVLink Inspector — Display and chart received MAVLink messages/values.

Edit on GitHub
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Log Download (Analyze View)

The Log Download screen (Analyze > Log Download) is used to list (Refresh), Download

and Erase All log files from the connected vehicle.

‘ QGroundContral = O x

Back < & Analyze Tools

Log Download Log Download allows you to download binary log files from your vehide. Click Refresh to get list of available logs.

Date Status Refresh
‘Wednesday, 16 June 2021 5:54:56 PM Available
Thursday, 17 June 2021 3:12:12 PM Available

GeoTag Images

Bownload

MAVLnS Cansnie Thursday, 17 June 2021 5:50:53 PM : Available

Wednesday, 1 September 2021 9:06:25 AM Available Erace All
Wednesday, 1 September 2021 10:38:01 AM Available
‘Wednesday, 1 September 2021 1:34:30 PM Availabie
‘Wednesday, 1 September 2021 1:43:08 PM -, Available

MAVLink Inspector

Vibration

Edit on GitHub
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GeoTag Images (Analyze View)

The GeoTag Images screen (Analyze > GeoTag Images) allows you to geotag images from

a survey mission using information in the flight log.

INFO

This feature only works with PX4 flight stack logs. ArduPilot is hot supported.

‘ QGroundControl = O *

Back < [}1 Analyze Tools

Log Download Used to tag a set of im

directory which contains
@ GeoTag Images

MAVLink Console

MAVLInk Inspector
Select log:file

Vibration

Select image directory

(Cptionally) Select save directory  /TAGGED folder in your image folder

Select the log file, image directory and (optionally) output directory for geotagged images

using the buttons provided. Click Start Tagging to generate the geotagged images.

]
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MAVLink Console (Analyze View)

The MAVLink Console (Analyze > Mavlink Console) allows you to connect to the PX4

System Console and send commands.

INFO

The console only works when connected to hardware running the PX4 flight stack. PX4 SITL and

ArduPilot are not supported.

TIP

This is a very useful feature for developers as it allows deep access to the system. In particular, if
you are connected via Wifi, you can have this same level of access while the vehicle is flying.



‘ QGroundControl

Back < @l Analyze Tools

Log Download Provides a connection to the vehide's system sl

GeoTag Images

1
1

> MAVLink Consale Ll

MAVLInk Inspactor

Vibration

The view does not display any output except in response to commands. Once the vehicle

is connected, you can enter commands in the bar provided (for a full list of available

commands enter: ? ).

Command output is displayed in the view above the command bar. Click Show Latest to

jump to the bottom of the command output.

Edit on GitHub
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MAVLink Inspector

The MAVLink Inspector provides real-time information and charting of MAVLink traffic

received by QGroundControl.

WARNING

This feature is intended primarily for autopilot developers/vehicle creators. It is only supported on
desktop builds (Windows, Linux, Mac OS).

Back < @l Analyze Tools

Log Download Inspect real time MAVLInk messages,

GeoTag Images 1 ALTITUDE 0.8Hz

Co
1 ATTITUDE* 128Hz
MAVLink Console

Name ¥ Plot 1

1 ATTITUDE QUATERNION 12.8Hz
pt y time_boot_ms
"JQ MAVLink Inspector
oll
ATTITUDE TARGET 128Hz ©

pitch
Vibration
BATTERY_STATUS 0.0Hz

ESTIMATOR_STATUS
EXTENDED_5YS_STATE
GLOBAL_POSITION_INT
GPS_GLOBAL ORIGIN
GPS_RAW.INT
HEARTBEAT
HOME_POSITION
LINK_NODE STATUS

LOCAL_POSITION_NED

The inspector lists all received messages for the current vehicle, along with their source
component id and update frequency. You can drill down into individual messages to get
the message id, source component id, and the values of all the individual fields. You can

also chart field values in real time, selecting multiple fields from multiple messages to

display on one of two charts. [ DIsA_ }



To use the MAVLink Inspector:

1. Open Analyze View by selecting the QGroundControl application menu ("Q" icon in top

left corner) and then choosing the Analyze Tools button (from the Select Tool popup).

-
Select Tool Close

2. Select the MAVLink Inspector from the sidebar.

QiGroundCaontrol
Back < @1 Analyze Tools
Log Download Inspect real time MA)
GeoTag Images 1 ALTITUDE
MAVLInk Consale

|“Jé\| MaVLink Inspector
ATTITUDE_TAR{

Vibration

BATTERY_STA

The view will start populating with messages as they are received.

3. Select a message to see its fields and their (dynamically updating) value:



Message: ATTITUDE (20) 47.8Hz
1 ALTITUDE 1.0Hz
Component: 1

Count: 66466
1 ATTITUDE 47 8Hz

Name Value Type Piot1 Plot2
1 ATTITURE QUATERNION AT BHz

time_boot ms 2957504 uint32 t
ATTITUDE TARGET 30.8Hy roll -6.24175e-05 fioat

pitch 6.63456e-05 float
BATTERY_STATUS 0.8Hz yaw -0.00336109 float

rollspeed -0.,00433372 float
ESTIMATOR_STATUS 0.8Hz pitchspeed 0.00901357

finat

yawspeed -0.00172854 fioat
EXTENDED_SYS_STATE 1.0Hz

4. Add fields to charts by enabling the adjacent checkboxes (plot 1 is displayed below plot
2).
Message: ATTITUDE (30) 46.7Hz
Component: 1

Count: 79242

MName Value Type Piest1 Plot2

time_bool_ms 3213552 uint32.t
roll -0.00109535 float
pitch -(.000647495 float
yaw -0.00461185 float
rofispeed -0.000584393 float
pitchspeed -0.00544916 float
yawspeed 000245484 float

Scale: :SSEC -

T -
M O
M O
M O
H B
H B
H B

Range: |.-5.u1:0 s

-5.0032

-0.0048 §
DB:43.448 08:44.698 0B:45.048 0B-47.198 0B:48.448




» Fields can be added to only one chart.

» A chart can have multiple fields, and fields from multiple messages (these are listed

above each chart). Messages containing fields that are being charted are highlighted

with an asterisk.

1

1

|

1

1

ALTITUDE

ATTITUCE *

ATTITUDE_QUATERNION

ATTITU DE_TAR[E

BATTERY_STATUS

e The Scale and Range are set to sensible values, but can be modified if needed.

Edit on GitHub
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Troubleshooting QGC Setup

This topic lists troubleshooting information related to QGroundControl setup and

installation on the host computer.

TIP

Problems when using QGroundControl to interact with a vehicle are covered in: QGC Vehicle
Interaction Problems.

64-bit Windows: Audio in Unexpected Language

On Windows 64-bit machines QGroundControl may sometimes play audio/messages in a
language that does not match the Text-to-speech setting in Control Panel > Speech (e.g.

audio spoken in German on an English machine).

This can occur because 64-bit Windows only displays 64-bit voices, while QGroundControl

is a 32-bit application (on Windows) and hence can only run 32-bit voices.

The solution is to set the desired 32-bit voice for your system:

1. Run the control panel application:
C:\Windows\SysWOW64\Speech\SpeechUX\sapi.cpl.

2. Make your desired Voice selection and then click OK at the bottom of the dialog.



- Speech Properties ? P4

Speech Recognttion Text to Speech

You can control the voice properties, speed and other options for
text4o-speech translation

Voice selection

Microsoft Hazel Deslttop - English (Great Britain) v
Microsoft David Desktiop - Englsh (United States
crosor arad lesxtion - Englis =3t Rt s

Microsoft Hedda Desktop - German

Microsoft Zrrs Desktop - Engish (Unted States)

|Tnu have selected Microsoft Hazel Desktop - English (Great Britain) as the computer’s

" Preview Voice

INFO

Menu On this page

Windows: Ul Rendering/Video Driver Issues

If you experience Ul rendering issues or video driver crashes on Windows, this may be
caused by "flaky" OpenGL drivers. QGroundControl provides 3 shortcuts that you can use

to start QGroundControl in "safer" video modes (try these in order):

e QGroundControl: QGC uses OpenGL graphics drivers directly.

e GPU Compatibility Mode: QGC uses ANGLE drivers, which implement OpenGL on top of
DirectX.

 GPU Safe Mode: QGC uses a software rasterizer for the Ul (this is very slow).

Windows: Doesn't connect to Vehicle over WiFi

If QGroundControl sits forever (for example, Waiting For Vehicle Connection) when trying
to connect to the vehicle over Wifi, a possible cause is that IP traffic is being blockral-sﬁ

v



firewall software (e.g. Windows Defender, Norton, etc.).
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The solution is to allow the QGroundControl app through the firewall.

INFO

It is possible to simply switch the network profile from Public to Private to allow connections, but
this exposes your PC to the Network, so be careful

If using Windows Defender:

 In the Start bar, enter/select: Firewall & Network Protection (System Settings).
» Scroll to and select the option: Allow an app through firewall.

o Select QGroundControl and change the Access selector to Allow.

TIP

Programs are listed in alphabetical order by description (not filename). You'll find QGC under O:
Open source ground control app provided by QGroundControl dev team

Ubuntu: Video Streaming Fails (Missing Gstreamer)

On Ubuntu you must install Gstreamer components in order to see video streams. If these

are not installed QGroundControl is unable to create the gstreamer nodes and fails with:

sh
VideoReceiver::start() failed. Error with gst_element_factory_make( ‘avdec_h264")

]



The download/install instructions for Ubuntu include GStreamer setup information.

Ubuntu 18.04: Video Streaming Fails on Dual Video Adapter
Systems

The version of GSteamer in Ubuntu 18.04 has a bug that prevents video displaying when
using a VA API based decoder (i.e. vaapih264dec etc.) on systems that have both Intel and
NVidia video display adapters.

INFO

More generally, while the problem is known to occur on Ubuntu 18.04 with Intel and NVidia VGAs, it
might occur on any linux system and other types of (dual) VGAs.

The easiest way to get QGroundControl to work in this case is to start it using the

following command line:

LIBVA_DRIVER_NAME=fakedriver ./QGroundControl) will this make the



Other alternatives are to disable one of the VGAs, uninstall VA APl components, or upgrade
to GStreamer 1.16 (there is no easy way to do this on Ubuntu 18.04 - please contribute a

recipe if you find one!)

Ubuntu 16.04: GLIBC_2.27 not found

The pre-built Applmages for QGroundControl 4.0 (and later) can only run on Ubuntu 18.04
LTS (or later). They do not run on Ubuntu 16.04.

If you try you will get the error as shown:

sh
$ ./QGroundControl.AppImage

/tmp/.mount_i4hPuB/QGroundControl: /lib/x86_64-linux-gnu/libm.so.6: version “GLIBC_2.2:
< b

If you need to use Ubuntu 16.04 then one workaround is to build from source without the

video libraries.

Edit on GitHub
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Vehicle Connection Problems

Vehicle does not show up in Ul

QGC will automatically connect to a vehicle as soon as a communication link is created
(using USB, or WiFi, etc.) If you establish that link and you don't see your vehicle show up
in the QGC Ul you can use console logging to help debug the problem.

Use the following steps to debug the issue:

Start with the hardware vehicle link not connected. Don't plug in the USB connection
and/or establish the WiFi link in your OS for example.

e Turn on LinkManagerLog console logging in QGC. This will log output about the link

which QGC sees and connects to.
e Establish the hardware vehicle communication link.

e The console log output should display something like this:

[D] at /Users/travis/build/mavlink/qgroundcontrol/src/comm/LinkManager.cc:563 - "Wai
[D] at /Users/travis/build/mavlink/qgroundcontrol/src/comm/LinkManager.cc:563 - "Wai
[D] at /Users/travis/build/mavlink/qgroundcontrol/src/comm/LinkManager.cc:563 - "Wai
[D] at /Users/travis/build/mavlink/qgroundcontrol/src/comm/LinkManager.cc:563 - "Wai
[D] at /Users/travis/build/mavlink/qgroundcontrol/src/comm/LinkManager.cc:572 - "Wai
[D] at /Users/travis/build/mavlink/qgroundcontrol/src/comm/LinkManager.cc:613 - "New

< G 4

e The first few lines indicate QGC has established a hardware link and finally the auto-

e

connect.



If you don't see any of this then QGC is not recognizing the hardware link. To see if your

hardware is being recognized at the OS level do this:

o Start with the hardware vehicle link not connected. Don't plug in the USB connection
and/or establish the WiFi link in your OS for example.

e Turn on LinkManagerVerboseLog console logging in QGC. This will log output for all serial

hardware connections that QGC recognizes.
» You will see continuous output of the serial ports on your device.
e Plug in your USB comm device.

e You should see a new device show in in the console output. Example:

[D] at /Users/travis/build/mavlink/qgroundcontrol/src/comm/LinkManager.cc:520 - "---
[D] at /Users/travis/build/mavlink/qgroundcontrol/src/comm/LinkManager.cc:521 - "por
[D] at /Users/travis/build/mavlink/qgroundcontrol/src/comm/LinkManager.cc:522 - "sys
[D] at /Users/travis/build/mavlink/qgroundcontrol/src/comm/LinkManager.cc:523 - "des

[D] at /Users/travis/build/mavlink/qgroundcontrol/src/comm/LinkManager.cc:524 - "man
[D] at /Users/travis/build/mavlink/qgroundcontrol/src/comm/LinkManager.cc:525 - "ser
[D] at /Users/travis/build/mavlink/qgroundcontrol/src/comm/LinkManager.cc:526 - "ven

[D] at /Users/travis/build/mavlink/qgroundcontrol/src/comm/LinkManager.cc:527 - "pro
< — >

o After that it should continue to log a connection to that device as shown in the first
example.

If you don't see a new serial port should up in the console output when you plug it in then

something is likely wrong with your hardware at the OS level.

Error: Vehicle is not responding

This indicates that although QGC was able to connect to the hardware link to your vehicle
there is no telemetry going back and forth on the link. This can unfortunately indicate a

number of problems:

e Hardware communication setup problems

e Firmware problems

e



Lastly it can happen if QGC attempts to automatically connect to a device which is
connected to your computer which isn't a vehicle. You can identify this case using the
steps above and noting the device information which QGC is attempting to connect to. In
order to make auto-connect work the filter it uses on devices it attempts to auto-connect
to is somewhat broad and can be incorrect. If you find this happening you will need to turn
off auto-connect from General Settings and create a manual connection to the comm link
for your vehicle. You can also remove the device causing the problem from your computer

but that may not always be possible.

Edit on GitHub
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